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Thank you for purchasing the Daqstation DX1000T (DX).This 
manual describes the basic operating procedures and installation 
and wiring procedures of the DX1000T. To ensure correct use, 
please read this manual and the manuals below thoroughly before 
beginning operation.

	 Paper Manual
Manual Title Manual No.
DX1000T Operation Guide IM 04L45B01-02EN

This manual.
Control of Pollution Caused by the Product IM 04L41B01-91C

Gives a description of pollution control.

	 Electronic Manuals Provided on the Accompanying CD
Manual Title Manual No.
DX1000/DX1000N User’s Manual IM 04L41B01-01E

Describes how to use the DX. The communication and 
network functions, custom display functions, and some of the 
options are excluded.

DX1000/DX1000N/DX2000 IM 04L41B01-03E
Multi Batch (/BT2) User’s Manual

Describes how to use the multi batch function (/BT2 option).
DX1000/DX1000N/DX2000 Custom IM 04L41B01-04E
Display User’s Manual

Describes how to use the custom display function.
DX1000/DX1000N/DX2000 Advanced 
Security (/AS1) User’s Manual

IM 04L41B01-05EN

Describes how to use the advanced security function  
(/AS1 option).

DX1000/DX1000N/DX2000 IM 04L41B01-17E
Communication Interface User’s Manual

Describes how to use the communication functions using the 
Ethernet and serial interfaces.

DX1000/DX1000N/DX2000 IM 04L41B01-18E
EtherNet/IP Communication Interface User’s Manual

Describes how to use communication functions through the 
EtherNet/IP interface.

DX1000/DX1000N/DX2000 IM 04L41B01-19E
PROFIBUS-DP (/CP1) Communication Interface User’s Manual

Describes how to use communication functions through the 
PROFIBUS-DP interface (/CP1 option).

	 DAQSTANDARD Manuals
All manuals other than IM 04L41B01-66EN are contained in the 
DAQSTANDARD CD.
Manual Title Manual No.
DAQSTANDARD Viewer User’s Manual IM 04L41B01-63EN
DAQSTANDARD Hardware Configurator 
User’s Manual

IM 04L41B01-64EN

DAQSTANDARD DX-P Hardware 
Configurator User’s Manual

IM 04L41B01-65EN

Installing DAQSTANDARD IM 04L41B01-66EN

Differences between the DX1000T and the DX1000
Some of the DX1000T and DX1000 specifications are 
different. When you view the electronic manual provided on 
the accompanying CD, note the following differences in the 
specifications.
•	 In addition to using keys, you can use the touch panel to control 

the DX1000T.
•	 The DX1000T's dust and water protection specification is 

IEC529-IP32.
•	 The DX1000T cannot be controlled remotely (with the /KB1 and 

/KB2 easy text entry options). No remote control is included with 
the DX1000T.

Notes
•	 The contents of this manual are subject to change without prior 

notice as a result of continuing improvements to the instrument’s 
performance and functions.

•	 Every effort has been made in the preparation of this manual to 
ensure the accuracy of its contents. However, should you have 
any questions or find any errors, please contact your nearest 
YOKOGAWA dealer.

•	 Copying or reproducing all or any part of the contents of this 
manual without YOKOGAWA’s permission is strictly prohibited.

•	 The TCP/IP software of this product and the document 
concerning the TCP/IP software have been developed/created 
by YOKOGAWA based on the BSD Networking Software, 
Release 1 that has been licensed from the Regents of the 
University of California.

Revisions
1st Edition: April 2011
2nd Edition: October 2011

Trademarks
•	 vigilantplant, DAQSTATION, Daqstation, and DXAdvanced are 

registered trademarks of Yokogawa Electric Corporation.
•	 Microsoft and Windows are registered trademarks or trademarks 

of Microsoft Corporation in the United States and/or other 
countries.

•	 Adobe and Acrobat are registered trademarks or trademarks of 
Adobe Systems Incorporated.

•	 Kerberos is a trademark of the Massachusetts Institute of 
Technology (MIT).

•	 Company and product names that appear in this manual are 
registered trademarks or trademarks of their respective holders.

•	 The company and product names used in this manual are not 
accompanied by the registered trademark or trademark symbols 
(® and ™).

 

2nd Edition: October 2011 (YK)
All Rights Reserved, Copyright © 2011, Yokogawa Electric Corporation
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Safety Precautions
This instrument conforms to IEC safety class I (provided with 
terminal for protective grounding), Installation Category II, and 
EN61326-1 (EMC standard), Measurement Category II (CAT II)*.
*	 Measurement category II (CAT II) applies to measuring circuits 

connected to low voltage installation, and electrical instruments 
supplied with power from fixed equipment such as electric 
switchboards.

This instrument is an EN61326-1 (EMC standard) class A 
instrument (for use in commercial, industrial, or business 
environments).
The general safety precautions described here must be observed 
during all phases of operation. If the DX is used in a manner not 
described in this manual, the DX safety features may be impaired. 
Yokogawa Electric Corporation assumes no liability for the 
customer’s failure to comply with these requirements.
The DX is designed for indoor use.

•	 About This Manual
•	 Please pass this manual to the end user. We also ask you to 

store this manual in a safe place.
•	 Read this manual thoroughly and have a clear understanding of 

the product before operation.
•	 This manual explains the functions of the product. It does not 

guarantee that the product will suit a particular purpose of the 
user.

•	 Precautions Related to the Protection, Safety, and Alteration of 
the Product
The following safety symbols are used on the product and in this 
manual.

“Handle with care.”  To avoid injury and damage to 
the instrument, the operator must refer to the 
explanation in the manual.

Protective ground terminal

Functional ground terminal (do not use this terminal 
as a protective ground terminal.)

Alternating current

Direct current

ON (power)

OFF (power)

•	 For the protection and safe use of the product and the system in 
which this product is incorporated, be sure to follow the instructions 
and precautions on safety that are stated in this manual whenever 
you handle the product. Take special note that if you handle the 
product in a manner that violates these instructions, the protection 
functionality of the product may be damaged or impaired. In such 
cases, YOKOGAWA does not guarantee the quality, performance, 
function, and safety of product.

•	 When installing protection and/or safety circuits such as lightning 
protection devices and equipment for the product and control 
system or designing or installing separate protection and/or 
safety circuits for fool-proof design and fail-safe design of the 
processes and lines that use the product and the control system, 
the user should implement these using additional devices and 
equipment.

•	 If you are replacing parts or consumable items of the product, 
make sure to use parts specified by YOKOGAWA.

•	 This product is not designed or manufactured to be used in 
critical applications that directly affect or threaten human lives. 
Such applications include nuclear power equipment, devices 
using radioactivity, railway facilities, aviation equipment, air 
navigation facilities, aviation facilities, and medical equipment. 
If so used, it is the user’s responsibility to include in the system 
additional equipment and devices that ensure personnel safety.

•	 Do not modify this product.

	 WARNING

	 •	 Use the Correct Power Supply
	 Ensure that the source voltage matches the voltage of the 

power supply before turning ON the power. In the case of a 
desktop type, ensure that it is within the maximum rated voltage 
range of the provided power cord before connecting the power 
cord.

	 •	 Use the Correct Power Cord and Plug (Desktop Type)
	 To prevent electric shock or fire, be sure to use the power 

cord supplied by YOKOGAWA. The main power plug must 
be plugged into an outlet with a protective earth terminal. Do 
not disable this protection by using an extension cord without 
protective earth grounding. 

	 The power cord is designed for use with this instrument. Do not 
use the power cord with other instruments.

	 •	 Connect the Protective Grounding Terminal
	 Make sure to connect the protective grounding to prevent 

electric shock before turning ON the power.
	 The power cord that comes with the desktop type is a three-

prong type power cord. Connect the power cord to a properly 
grounded three-prong outlet.

	 •	 Do Not Impair the Protective Grounding
	 Never cut off the internal or external protective grounding wire 

or disconnect the wiring of the protective grounding terminal. 
Doing so invalidates the protective functions of the instrument 
and poses a potential shock hazard.

	 •	 Do Not Operate with Defective Protective Grounding
	 Do not operate the instrument if the protective grounding might 

be defective. Also, make sure to check them before operation.
	 •	 Do Not Operate in an Explosive Atmosphere

	 Do not operate the instrument in the presence of flammable 
liquids or vapors. Operation in such an environment constitutes 
a safety hazard.

	 Prolonged use in a highly dense corrosive gas (H2S, SOx, etc.) 
will cause a malfunction.

	 •	 Do Not Remove Covers
	 The cover should be removed by YOKOGAWA’s qualified 

personnel only. Opening the cover is dangerous, because some 
areas inside the instrument have high voltages.

	 •	 Ground the Instrument before Making External Connections
	 Connect the protective grounding before connecting to the item 

under measurement or control unit.
	 •	 Damage to the Protection

	 Operating the instrument in a manner not described in this 
manual may damage the instrument’s protection.

	 CAUTION

	 This instrument is a Class A product. Operation of this 
instrument in a residential area may cause radio interference, in 
which case the user is required to take appropriate measures to 
correct the interference.

•	 Exemption from Responsibility
•	 YOKOGAWA makes no warranties regarding the product except 

those stated in the WARRANTY that is provided separately.
•	 YOKOGAWA assumes no liability to any party for any loss 

or damage, direct or indirect, caused by the user or any 
unpredictable defect of the product.

•	 Handling Precautions of the Software
•	 YOKOGAWA makes no warranties regarding the software 

accompanying this product except those stated in the 
WARRANTY that is provided separately.

•	 Use the software on a single PC.
•	 You must purchase another copy of the software, if you are to 

use the software on another PC.
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•	 Copying the software for any purposes other than backup is 
strictly prohibited.

•	 Please store the original media containing the software in a safe 
place.

•	 Reverse engineering, such as decompiling of the software, is 
strictly prohibited.

•	 No portion of the software supplied by YOKOGAWA may be 
transferred, exchanged, or sublet or leased for use by any third 
party without prior permission by YOKOGAWA.

Handling Precautions of the DX
•	 Do not push or scrape the display (the touch panel surface) 

with a sharp blade or pointed object. Doing so may damage the 
instrument.

•	 Use care when cleaning this instrument, especially its plastic 
parts. Use a soft dry cloth. Do not use organic solvents, such 
as benzene or thinner, or other cleansers. They may cause 
discoloring and deformation.

•	 Keep electrically charged objects away from the signal terminals. 
If you do, the DX may malfunction.

•	 Do not apply volatile chemicals to the display, panel keys, etc. 
Do not allow rubber and vinyl products to remain in contact 
with the DX for long periods of time. If you do, the DX may 
malfunction.

•	 When not in use, make sure to turn OFF the power switch.
•	 If there are any symptoms of trouble such as strange odors or 

smoke coming from the DX, immediately turn OFF the power 
switch and the power supply source. Then, contact your nearest 
YOKOGAWA dealer.

Handling Precautions of the External Storage 
Medium (CF Card)

•	 Use caution in the handling of the external storage medium as it 
is a delicate product.

•	 Write operation to storage media may fail under high-
temperature or low-temperature environments. If you are using 
the DX in a low-temperature environment (around 10 °C or 
less), use the DX after the warm-up time (at least 30 minutes) 
has elapsed. If you are using the DX under a high-temperature 
environment (around 40 °C or more), it is recommended that the 
external storage medium be inserted into the drive when saving 
the data and be removed after the data storage operation is 
finished.

•	 Remove the storage medium from the drive when turning the DX 
ON/OFF.

•	 Touching the compact flash section when static electricity is built 
up on the human body can lead to erroneous operation.

•	 For the general handling precautions of the external storage 
medium, see the instruction manual that came with the external 
storage medium.

	 CAUTION

•	 Do not eject the external storage medium while the access 
indicator is illuminated. This can damage the data.

•	 Do not access the storage medium in a place with vibrations or 
shock. The storage medium or drive may malfunction.

Checking the Contents of the Package
Unpack the box and check the contents before operating the 
instrument. If some of the contents are not correct or missing or 
if there is physical damage, contact the dealer from which you 
purchased them.

	 DX
A name plate is located on the top panel of the DX (side panel on 
models with the /H5[ ] option). Check that the model name and 
suffix code given on the name plate match those on your order.

name plate

DISP/ENTER

6

9

7

8
10

11

12

1

2

3

4 5

100-240V AC

50/60Hz 100VA MAX
N

L

MODEL

FREQUENCY
NO.

SUFFIX

SUPPLY

STYLE
H S

	 NO. (Instrument Number)
When contacting the dealer from which you purchased the 
instrument, please give them the instrument number.

	 MODEL and SUFFIX Cod

 -3

 -4
 -1
 -2

Model code Suffix code Optional
code Description

Daqstation DX1000T 2ch, 125ms (25ms)
Daqstation DX1000T 4ch, 125ms (25ms)
Daqstation DX1000T 6ch, 1s (125ms)
Daqstation DX1000T 12ch, 1s (125ms)
Standard Memory (400 MB)

CF card (with medium)
English/German/French, deg F, and DST 
(English version of DAQSTANDARD included)

DX1002T
DX1004T
DX1006T
DX1012T
Internal memory
 size
External storage medium
Language

Options /A1 Alarm output 2 points*1

/A2 Alarm output 4 points*1

/A3 Alarm output 6 points*1*2

/C2 RS-232 interface*3

/C3 RS-422/485 interface*3

/F1 FAIL/Status output*2
/H2 Clamped input terminal (detachable)
/H5[ ] Desktop type*4

/M1 Mathematical functions
/N1 Cu10, Cu25 RTD input/3 leg isolated RTD
/N2 3 leg isolated RTD*5

/N3 Extended input type (PR40-20, JPt50, etc.)
/P1 24 VDC/AC power supply*4

/R1 Remote control
/TPS2 24VDC transmitter power supply (2 loops)*6
/TPS4 24VDC transmitter power supply (4 loops)*7
/USB1 USB interface
/PM1 Pulse input (including remote control and mathmatical functions)*8
/CC1 Calibration correction function
/BT2 Multi batch function*9

/CP1 PROFIBUS-DP*3

/AS1 Advanced security function

*1 /A1, /A2, /A3 cannot be specified together.
*2 /A3 and /F1 cannot be specified together.
*3 /C2, /C3, and /CP1 cannot be specified together.
*4 /H5[  ] can be specified for only DX1002T, DX1004T, DX1006T, and DX1012T.
  D:   Power cord UL, CSA st’d
  F:   Power cord VDE st’d
  R:   Power cord AS st’d
  J:   Power cord BS st’d
  H:   Power cord GB st’d
  Null (/H5): Only for /P1 model (without power cord)
*5 /N2 can be specified for only DX1006T and DX1012T.
*6 In case that /TPS2 is specified, /TPS4, /A2, /A3, or /F1 cannot be specified 

together.
*7 In case that /TPS4 is specified, /TPS2, /A1, /A2, /A3, or /F1 cannot be 

specified together.
*8 In case that /PM1 is specified, /A3, /M1, /R1, /TPS2, or /TPS4 cannot be 

specified.  And combination of /A2, /F1 cannot be specified together.
*9 /BT2 can only be specified for the DX1006T and DX1012T.
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	 Standard Accessories
The standard accessories below are supplied with the instrument. 
Check that all contents are present and undamaged.

1 2 4 3 

6 7 5 

8. One of these power cord types is supplied according  
 

/H5F /H5D /H5R 

/H5H /H5J 

to the instrument’s suffix code.

No. Name Part Number/ 
Model

Qty. Notes

1 Terminal screws E9655FX 5 M4 (spares)
2 Mounting brackets B9900BX 2 For panel mounting 

Except for the /H5[ ] 
models.

3 Door lock key B8706FX 2 –
4 DAQSTANDARD DXA120 1 CD. Contains the 

software and user’s 
manuals.

5 DX1000T Operation 
Guide (this manual)

IM 04L45B01-
02EN

1 A4 size

DXA120 Installing 
DAQSTANDARD

IM 04L41B01-
066EN

1

Control of Pollution 
Caused by the 
Product

IM 04L41B01-91C 1

6 User’s Manuals 
for the DX1000/
DX1000N/DX2000

B8706ZZ 1 CD. Contains the 
PDF file of the user’s 
manual.

7 CF card B8706NQ 1 128 MB (The size and 
model may change.)

8 Power cord A1006WD 1 Supplied only for 
models with the /H5D 
option. Maximum 
rated voltage: 125 V

A1009WD 1 Supplied only for 
models with the /H5F 
option. Maximum 
rated voltage: 250 V

A1024WD 1 Supplied only for 
models with the /H5R 
option. Maximum 
rated voltage: 250 V

A1054WD 1 Supplied only for 
models with the /H5J 
option. Maximum 
rated voltage: 250 V

A1064WD 1 Supplied only for 
models with the /H5H 
option. Maximum 
rated voltage: 250 V

	 Optional Accessories (Sold Separately)
The following optional accessories are available for purchase 
separately. If you make an order, make sure that all contents 
are present and undamaged. For information about ordering 
accessories, contact the dealer from which you purchased the DX.

No. Name Model Minimum Notes
Q’ty

1 CF card 772093 1 512 MB
772094 1 1 GB
772095 1 2 GB

2 CF card adapter 772090 1 –
3 Shunt resistor 415920 1 250 Ω ± 0.1%

(for screw input terminal) 415921 1 100 Ω ± 0.1%
415922 1 10 Ω ± 0.1%

4 Shunt resistor
(for clamped input 
terminal)

438920 1 250 Ω ± 0.1%
438921 1 100 Ω ± 0.1%
438922 1 10 Ω ± 0.1%

5 Mounting brackets B9900BX 2 –
6 Door lock key B8706FX 1 –
7 Validation document – 1 Electronic file

Style number, release number, and firmware 
version number of the DX

Style number:	 This is the DX hardware number that is indicated 
on the name plate.

Release number:	 This is the DX firmware number that is indicated 
on the name plate. The number corresponds to 
the integer part of the firmware version number.

Example: �If the firmware version number is 4.11, the release 
number is 4.

Firmware version number: This number is displayed on the DX 
system information screen. For the procedure, 
see section 2.5, “Viewing the DX Information” 
in the DX1000/DX1000N User’s Manual (IM 
04L41B01-01E).

MODEL

FREQUENCY
NO.

SUFFIX

SUPPLY

STYLE
H
3 4

S

Style number
Release number
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Protection of Environment
	 Control of Pollution Caused by the Product

For details, see the Control of Pollution Caused by the Product 
(IM04L41B01-91C).

	 Proper Disposal of This Product
This is an explanation of how to dispose of this product based 
on Waste Electrical and Electronic Equipment (WEEE), Directive 
2002/96/EC. This directive is only valid in the EU.
•	 Marking
	 This product complies with the WEEE Directive (2002/96/EC) 

marking requirement.
	 The affixed product label (see below) indicates that you must not 

discard this electrical/electronic product in domestic household 
waste.

	

•	 Product Category
	 With reference to the equipment types in the WEEE directive 

Annex 1, this product is classified as a “Monitoring and Control 
instrumentation” product.

	 Do not dispose in domestic household waste.
	 To return unwanted products, contact your local Yokogawa 

Europe B. V. office.

Conventions Used in This Manual
•	 This manual covers information regarding DX1000Ts that have a 

suffix code for language “-2” (English).
•	 For details on how to set the language, see section 2.6, 

“Changing the Language” in the DX1000/DX1000N User’s 
Manual (IM 04L41B01-01E).

	 Unit
K:	Denotes 1024. Example: 768 KB (file size)
k:	 Denotes 1000.
The following markings are used in this manual.

	

Improper handling or use can lead to injury to the user or damage 
to the instrument. This symbol appears on the instrument to 
indicate that the user must refer to the user’s manual for special 
instructions. The same symbol appears in the corresponding place 
in the user’s manual to identify those instructions. In the manual, 
the symbol is used in conjunction with the word “WARNING” or 
“CAUTION.”
	 WARNING

Calls attention to actions or conditions that could cause serious or 
fatal injury to the user, and precautions that can be taken to prevent 
such occurrences.
	 CAUTION

Calls attentions to actions or conditions that could cause light 
injury to the user or damage to the instrument or user’s data, and 
precautions that can be taken to prevent such occurrences.
					    Note
Calls attention to information that is important for proper operation 
of the instrument.
					  
Indicates after this mark reference to related procedure or 
explanation.
		  Bold characters
Indicates character strings that appear on the screen and the 
operation keys.

Opening the Electronic Manuals
The accompanying CD contains PDF files of the manuals. When 
you load the CD into the CD-ROM drive on your PC, a startup 
screen appears. Click the manual title to open the respective 
manual.
If the startup screen does not appear, double-click DX_manual in 
My Computer, and open the manuals in the English directory.
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Introduction to Functions

Measured Items
You can connect DC voltage, thermocouple, RTD, and ON/OFF input and measure 
various values such as temperature and flow rate. The DX samples the input signals at 
the scan interval to obtain the measured values. The fastest scan interval is 25 ms on the 
DX1002T, and DX1004T and 125 ms on the DX1006T, and DX1012T.
Up to four alarm conditions can be set for each measurement channel.

Data Storage Function
There are two methods of recording measured data. One is to record the measured data 
continuously, and the other is to record only when certain events occur such as alarms. 
The measured data is recorded to the internal memory at a specified interval. The data in 
the internal memory can be stored to a CF card automatically or manually. By connecting 
to a network via the Ethernet interface, the measured data can also be automatically 
transferred to an FTP server on a network.

		

DX

Measurement input

Ethernet
Automatic data transfer to an FTP server

CF card

FTP server

Internal memory

Display Function
Measured data can be displayed as trends, numeric values, and bar graphs for each 
group. In addition, the overview display can be used to display and monitor all channels 
on a single screen.

		

Trend display Numeric (digital) display Overview display Bar graph display 

Other Functions
Computation Function (option) Various types of computation can be performed by 

assigning equations to computation channels.
FAIL/status output function (option) Outputs an alarm when the DX fails. The function 

also monitors the DX status such as the remaining 
amount of internal memory and outputs alarms.

Remote control function (option) A specified action is executed when a remote input 
signal is applied to the terminal on the rear panel.

Security function Enables only registered users can operate the 
DX. The function can also be used to prohibit key 
operation.

Communication function The Ethernet interface can be used to monitor the 
DX using a Web browser and transmit e-mail when 
an event occurs such as an alarm. In addition, 
data of devices on the network can be loaded and 
displayed using the Modbus protocol.

DAQSTANDARD
The accompanying software program, DAQSTANDARD, can be used to display the 
measured data, convert the measured data format, and create DX setup data.



9IM 04L45B01-02EN

DX System Configuration
The DX can be used to configure a system as shown below.
Referenced sections are of the DX1000/DX1000N User’s Manual.
Referenced pages are of this manual.

Ethernet

Sec. 3.5–3.8

Serial 
communication*

RS-232, RS-422/485, or PROFIBUS-DP*

Transmitter power supply*

Page 71

PC

PLC

PC

DX

RecorderTemperature
controller

FAIL/status output*

Sec. 2.9

Sec. 2.11

Signal input
Sec. 3.3

Pulse input*

Sec. 3.10

Sec. 7.1

Page 24

Keys

Sec. 2.11

Sec. 2.12

*: Option

PLC (programmable
logic controller) 

EtherNet/IP

Communication Interface User’s Manual
EtherNet/IP Communication Interface User’s  Manual
PROFIBUS-DP Communication Interface User’s Manual

USB port*

Alarm output*

CF card

USB flash memory

Keyboard

Barcode reader*

Remote input*

Terminology
•	 Memory sample
	 The operation of recording measured data.
•	 Memory start
	 The operation of starting memory sampling.
•	 Memory stop
	 The operation of stopping memory sampling.
•	 Display data
	 The waveform data shown on the DX display. The data recorded at the sampling 

interval for the displayed data.
•	 Event data
	 Measured data recorded at a sampling interval separate from that of the display data.

Introduction to Functions



10 IM 04L45B01-02EN

Names of Parts

Front View

USB CF  CARD

NO.Do not remove the cover.
Repair by trained personnel only.

START USER FUNC ESC MENUSTOP

Key panel opened

Front cover opened

LCD
Display various operation displays 
such as the trend display as well as 
setup displays.

Power indicator
Illuminates in red when the 
power is turned ON. Illuminates 
in green while memory 
sampling is in progress.

Power switch

USB port
A USB port conforming to Rev. 
1.1.

Label (front of the key panel cover)
Write arbitrary labels for your
convenience.

Front cover (key panel)
Open the front cover by pulling the 
cover while holding down the tab at 
the center of the upper section of the 
cover.

When closing the front cover, press 
the front cover in until the tab at the 
center of the upper section of the 
cover is all the way up. If the front 
cover is not closed completely, the 
water and dust proof capability may 
be impaired.

CF card slot

Lock key

CF card access indicator

CF card eject button
Used when ejecting the CF card.

Key panel cover
Open the cover by pinching the 
left tab and pulling forward.

Door lock key (included)
Insert the pin in the left hole to lock.
Insert the pin in the right hole to unlock.

DISP/ENTER

6

9

7

8
10

11

12

1

2

3

4 5

CAUTION
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Rear Panel

Ethernet port
A 10Base-T port.

USB port (/USB1 option)
A USB Rev. 1.1 compliant port.

Optional terminals (/A[ ], /F1, /R1, 
/TPS[ ], and /PM1 options)
Used to connect optional 
input/output signal wires.

Power supply terminals 

Serial port
(/C3 option)
RS-422/485 port.

Serial port
(/C2 option)
RS-232 port.

Input terminals (screw 
terminals or clamped 
terminals; /H2 option)
Used to connect input signal. 

PROFIBUS-DP port
(/CP1 option)
PROFIBUS connector.

Desktop Type (/H5[ ] Option)

	

Power 
connector

Handle

Feet and Stand

Functional ground 
terminal

Names of Parts
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DX1000T Workflow

When using the DX for the first time, carry out the following procedure.

		

Installation 

Wiring 

Power ON 

Environmental  
Settings 

Functional  
Settings 

Measurement 

Data  
Management 

Install the DX.

Connect input/output wires to the terminals and connectors on the 
rear panel, and connect the power cord.

Turn the power ON.

Set the date/time, load the CF card, and so on.

Set measurement functions.

Start the measurement.  Perform operations such as switching the 
screen and writing messages.  Save the measured data. 

Check and manage the measured data.
Use the accompanying software program, DAQSTANDARD, to  display 
the measured data and convert the measured data to Excel, Lotus, and 
ASCII formats. 

    DAQSTANDARD Viewer User's manual (IM 04L41B01-63EN)

On a DX with advanced security (/AS1 option), carry out the following procedure after 
turning the DX on.

		

User 
Registration

Environmental 
Settings

Functional 
Settings

Measurement

Data 
Management

CF Card 
Insertion

Register the users who will operate the DX.
 Advanced Security Function (/AS1 option) User’s Manual
(IM04L41B01-05EN)

Check the measured data, and attach approval information 
to the measured data file.
 Advanced Security Function (/AS1 option) User’s Manual
(IM04L41B01-05EN)
You can also attach approval information to the measured data file 
by using the accompanying software program, DAQSTANDARD.
  DAQSTANDARD Viewer User’s Manual (IM 04L41B01-63EN)

Set the date/time.

Insert a CF card into the DX.

Set measurement functions.

Start the measurement. Perform operations such as switching 
the screen and writing messages. Save the measured data.

Page 62 and subsequent pages

Page 65 and subsequent pages

Page 39 and subsequent pages

Page 39 and subsequent pages

Page 13

Page 60 and subsequent pages

Page 18 and 24

Page 24

Page 18

Page 19 and subsequent pages, Page 28 and subsequent pages

Page 19 and subsequent pages, Page 28 and subsequent pages



13IM 04L45B01-02EN

Turning the Power ON/OFF

Turning the Power ON

	 CAUTION
Before turning ON the power switch, check that
•	 The power cord/wires are connected correctly to the DX.
•	 The DX is connected to the correct power supply (see page 60).
If the input wires are connected in parallel with other devices, do not turn ON/OFF	
the power switch of the DX or another device during operation. This can have 
adverse effects on the measured values.

1. 	 Open the operation cover.

2. 	 Turn ON the power switch.
	After performing a self-test for a few seconds, the operation screen appears.

				  

3. 	 Close the operation cover.

	 CAUTION
•	� If nothing is displayed when the power switch is turned ON, turn OFF the 

power switch and check the points listed above one more time. After checking 
the points, turn ON the power switch again. If the DX still does not work, it is 
probably a malfunction. Contact your nearest YOKOGAWA dealer for repairs.

•	� If an error message is displayed on the screen, take measures according to the 
description in chapter 10, “Troubleshooting” in the DX1000/DX1000N User’s 
Manual.

•	� Turn ON the power switch, let the DX warm up for at least 30 minutes, and then 
start the measurements.

Turning the Power OFF

	 CAUTION
Before turning OFF the power switch, check that the external storage medium is 
not being accessed.

1. 	 Open the operation cover.

2. 	 Turn OFF the power switch.

3. 	 Close the operation cover.
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Basic Operation

Panel Keys

START USER FUNC ESC MENU STOP 

START USER FUNC ESC MENU STOP 

LCD 

Key panel 

Soft keys
Selects the menu that is displayed 
at the bottom of the screen.

START/STOP key
Memory start/stop. ESC key

Cancels an 
operation.

USER key
Executes the assigned 
operation.

Favorite key
Displays the operation screen (up to eight 
screens) that are registered to the key.

MENU key
Switches between the operation 
mode and setting mode.

FUNC key
• Displays the soft key menu in operation mode.
• Hold down this key at least 3 s in the setting mode to switch from the 
 setting mode to the basic setting mode.

DISP/ENTER key and four arrow 
keys (up, down, left, and right) 
Switches the operation screen. 
Selects and enters setup items. 

DISP/ENTER key 

Up arrow key 

Right arrow key 

Down arrow key 

Left arrow key 

Display
Status display section
Shows the display name, date/time, data recording, alarm 
icon, etc.

Data display section
Shows the measured data and the functional setup.
For displaying the scale, see section 5.7, in the 
DX1000/DX1000N User’s Manual (IM 04L41B01-01E).
For displaying the waveform and numeric display, see 
section 4.2, in the DX1000/DX1000N User’s Manual (IM 
04L41B01-01E).

Scale

Waveform
display

Numeric 
display
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Display on the Status Display Section
The following information is displayed in the status display section.

Memory sampling status

Error in internal memory.
Contact your nearest YOKOGAWA dealer for repairs.

Memory sampling icon

Data type
DISP: Display data
EVENT: Event data

Memory sampling progress
Displays the progress using a green bar graph.  The frame indicates the file 
save interval (display data) or the data length (event data).

Displays the remaining memory sampling time for the left bar graph.

Memory sampling
 stopped

Memory sampling
 in progress

If the “batch number-lot number” exceeds 20 characters, 
the “date and time” position is used to display the “batch 
number-lot number.”

Batch name and the display 
name are shown alternately. 

Name of the user logged in

Batch name, the display 
name, and date and time are
shown alternately.

Date and time
Displayed in yellow while the time is being corrected.

Display name or group name
For all channel display on the trend display, “All” is 
displayed.

When using the login function

When using the batch function

Date and time

Name of the user logged in
When using the login and batch functions

Date and time and the 
display name are shown 
alternately.

Displayed when any alarm is activated.
Blinks when there are alarms that are 
occurring but have not been acknowledged.

All alarms have been released after they 
have occurred, but there are alarms that 
have not been acknowledged.

The status assigned to the status output 
(/F1 option) is occurring.

CF card icon

E-mail transmission is enabled.

White icon: Computation started.

Yellow icon: Computation data dropout occurred.

CF card is being accessed.

Waiting.

Light blue icon: CF card in the slot is not 
recognized. Remove and reset it. 

CF card error.
Carry out the procedure below to reset the CF 
card icon to normal.
• Remove the CF card, and then reinsert it.
• Replace the CF card with a normal one.
• Format the CF card on the DX (the data on 
  the CF card will be erased).

The green level display indicates the amount 
of CF card used. If Media FIFO* is not enabled 
and the free space on the CF card falls below 
10%, the level indicator changes to red.
* See section 1.4, in the DX1000/DX1000N User’s 

Manual. Media FIFO is a function available on 
 release number 2 or later.

Alarm icon

status icon

Computation icon (/M1 or /PM1 option)

(Red)

(Green)
 

Displayed when the user is locked.
User Locked Icon (/AS1 option)

White icon: Keys are locked.

Yellow icon: Touch panel is locked.

Red icon: Keys and touch panel is locked.

Basic Operation
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Run Modes

Hold down FUNC
for 3 s or
Basic Setting Mode
> DISP/ENTER
(release number 3
or later)

End menu > DISP/ENTER or
ESC > DISP/ENTER
(release number 3 or later)

Power ON

Operation mode

Mode Transition Diagram

Basic setting modeSetting mode

Operation display
MENU key

MENU key 
or ESC key

Setting menu 
display

Setup display

MENU key 
or ESC key

DISP/ENTER 
key

Basic setting 
menu display

Setup display

DISP/ENTER 
key

ESC key
On a DX with advanced security 
(/AS1 option; release number 4 or later):
MENU key or ESC key > DISP/ENTER
or
End menu > DISP/ENTER

The DX has three modes.
Mode Description
Operation mode A mode for performing measurements.
Setting mode A mode in which input range, measurement method, and so on 

are configured. Settings can be changed when memory sampling 
is in progress excluding some items.

Basic setting mode A mode used to set basic items such as the scan interval and 
storage format of measured data. On a DX with advanced 
security (/AS1 option), the login settings can be changed during 
memory sampling.

* For further details on the basic setting mode and setting mode, see page 63.

Carry out the steps given in the following pages. It will help you to understand the DX 
operation.

Basic Operation
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Entering Values and Characters
The character/number input window and DISP/ENTER key are used to set the date/time, 
set the display span of the input range, set the tag, set the message string, enter the 
password, etc.

	

Number input window

Press the left and right arrow keys to move the cursor
to the appropriate input position.

Press the up arrow key to increase the number.
Press the down arrow key to decrease the number.

Character/number input window DISP/ENTER key and four arrow
 keys (up, down, left, and right)

Cursor
Text box for entering 
the character string

Select the character. 
(keypad)

Input status of the Ins soft key
Input status of the A/a/1 soft key

Left and right 
arrow soft keys

Entering Character Strings
When a window for entering a character string appears, enter it by performing the 
following key operation.
•	 Left and right arrow soft keys:	Moves the cursor in the text box to select the input 

position.
•	 Keypad:	 Use the four arrow keys (up, down, left, and right) to move the 

cursor on the keypad to select the desired character.
		  Ins:	 Switches between insert and overwrite.
		  Del:	 Deletes the character at the cursor position in the text box.
		  ENT:	 Enters the character string in the text box.
•	 DISP/ENTER key:	 Enter the character that you selected with the keypad in the text 

box or execute Ins, Del, or ENT.
•	 Bs soft key:	 Backspace. Deletes the character before the cursor.
•	 A/a/1 soft key:	 Selects uppercase alphabet (A), lowercase alphabet (a), or value 

(1).
		  The character type that you can enter changes each time 

you press the A/a/1 soft key. The selected character type is 
displayed at the bottom section of the character/number input 
window.

Basic Operation
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The contents of the screens in the operation examples below may change depending on 
which options are installed and how the settings are configured.
On a DX with advanced security (/AS1 option) you must first insert the CF card into the 
slot (see page 24).

Changing the Date/Time
In this example, we will change the date from the 1st to the 6th. After carrying out this 
step, reset the time to the correct date/time.

1.	 Display the operation mode screen.

					   

2.	 Press MENU once to display the setting menu.

3.	 Press the down arrow key once.
The cursor moves to Date/Time.

4.	 Press the right arrow key once.

					   

Select Date & Time.

5.	 Press DISP/ENTER once to open the Time set window.

6.	 Change the date from 01 to 06.
Select the input position:	� Press the right arrow key five times to move the cursor in 

the text box.
Enter the value:	 Press the up or down arrow key several times to display 6.
Enter the input:	 Press DISP/ENTER once.
Cancel the setting:	� Press ESC before pressing DISP/ENTER (entering the 

input).

					     Display the Time set window.
(Display after entering 6)

Basic Operation
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7.	 Press ESC twice or MENU once to return to the operation mode screen.

	 On a DX with advanced security (/AS1 option):

	 Press ESC twice or MENU once to display a confirmation screen. To return to the 
operation mode screen, select Yes, and press DISP/ENTER once.

Operation complete.

Operation Example in the Setting Mode: Changing the Input Range
Set the input range of channel 2 to thermocouple type T and 0.0 to 400.0°C.

		
Type T 
thermocouple Channel 2

DX

1.	 Display the operation mode screen.

					   

2.	 Press MENU once to display the setting menu.

3.	 Press the down arrow key twice to select Meas channel.

4.	 Press the right arrow key once.

					   

Select the Range, Alarm.

Basic Operation
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5.	 Press DISP/ENTER once.

					   

Select First-CH.

6.	 Press the +1 soft key once to set First-CH and Last-CH to 2.

7.	 Press the down arrow key once to move the cursor to Mode.

8.	 Press the TC soft key once. The cursor moves to Range, and the changed item is 
displayed in yellow.

					     Select TC.

9.	 Press the Next soft key.

10.	Press the T soft key once. The cursor moves to Span_L.

11.	Press the Input soft key once.

					     Display the Span_L setting window.

12.	Enter 0.0 in the Span Lower box.
Select the input position:	 �Press the right arrow key once to move the cursor in the 

text box to the right.
Delete the minus sign:	 Press the up arrow key once to delete the minus sign.
Delete the 2 and 0 in the same way.
Enter the input:		�  Press DISP/ENTER once. Span_L is set, and the cursor 

moves to Span_U.
Cancel the setting:		�  Press ESC before pressing DISP/ENTER (entering the 

input).

13.	Enter 400.0 in the Span Upper box.

	 See step 12 for the procedure.

Basic Operation
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14.	Press DISP/ENTER once. The changed items are entered, and the cursor returns 
to First-CH. The changed items change from yellow to white.

					   

15.	Press ESC three times or MENU twice to return to the operation mode screen.

	 On a DX with advanced security (/AS1 option):

	 Press ESC three times or MENU twice to display a confirmation screen. To return 
to the operation mode screen, select Yes, and press DISP/ENTER once.

Operation complete.

Basic Operation
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Operation Example in the Basic Setting Mode: Changing the Scan Interval
In this example, we will change the scan interval. Here, the scan interval on the DX1012T 
is changed to 2 s. The selectable scan intervals are different on the model, but the 
procedure is the same.

		
Type T 
thermocouple Channel 2

Measures every 2 s DX

1.	 Display the operation mode screen.

					   

2.	 Press MENU once to display the setting menu.

					   

3.	 Hold down FUNC for at least 3 s.
Alternatively, you can execute the following procedure to switch to Basic Setting mode.
Use the up or down arrow key to select Basic setting mode on the Menu tab, and 
press DISP/ENTER.
A confirmation window will appear. Select Yes, and press DISP/ENTER.

					   

Display the Basic Setting Mode menu.

Basic Operation
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4.	 Press the down arrow key twice to select A/D, Memory.

5.	 Press DISP/ENTER once.

					   

6.	 Press the down arrow key once to move the cursor to Scan interval.

7.	 Press the 2s soft key once. The cursor moves to A/D integrate, and the changed 
item is displayed in yellow.
Cancel the setting: Press ESC before pressing DISP/ENTER.

8.	 Press DISP/ENTER once. The changed items are entered, and the cursor returns 
to Scan mode.

					   

Set the scan interval to 2 s.

9.	 Press ESC once to return to the basic setting mode menu.

10.	Press ESC once more.
	Alternatively, use the up or down arrow key to select End, and press DISP/ENTER.

					   

Display the confirmation window.

11.	Press DISP/ENTER once. The settings are saved, and the DX returns to the 
operation mode screen.
Discard the changes:		  Select No and press DISP/ENTER.
Do not end the basic setting mode:	 Select Cancel and press DISP/ENTER.

Operation complete.

Basic Operation
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Inserting/Removing a CF Card
Inserting a CF Card

1.	 Open the operation cover.

					   

CF card
With the label “This side up” 
facing up

This side up

CAUTION

Forcing the CF card into the slot with 
the upside down may cause damage.

2.	 Insert the CF card into the slot.

					   

Displays the CF card icon
If the DX does not recognize the CF card, 
try reinserting it.

3.	 Close the operation cover.

Operation complete.

Removing a CF Card
<Operations in the Operation Mode>

1.	 Press FUNC once.

2.	 Press the Media eject soft key once.

					   

CF card icon 

Media eject

3.	 Press the CF soft key once. The message “Media can be removed safely” 
appears. Displays the CF card icon in blue.

4.	 Open the operation cover.

Basic Operation
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5.	 Press the CF card eject button. When you eject the CF card, the CF card icon 
disappears.

					   

Eject button

Press the eject button in until it clicks.
The eject button stops at depressed position.
Pinch the left and right sides of the CF card 
and remove it.

6.	 Close the operation cover.

Operation complete.

<Operation in the Basic Setting Mode>
1.	 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to 

basic setting mode), select the File/Initialize tab > Media eject > CF *, and press 
DISP/ENTER.
* Select CF if you have a choice between CF and USB.

					   

	The message “Media can be removed safely” appears.

2.	 Open the operation cover.

3.	 Press the CF card eject button. Remove the CF card.

4.	 Close the operation cover.

Operation complete.

Note
If you remove the CF card without carrying out the media eject procedure, the message “Media 
was removed compulsorily” appears. Remove the CF card by carrying out the procedure above 
to prevent damaging the data that is stored.

Basic Operation
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Saving the Setup Data
In this example, we will save the setup data to a file named “SF2” on the CF card.

1.	 Display the operation mode screen.

					   

2.	 Press MENU once to display the setting menu.

3.	 Press the right arrow key once to select the File tab.

4.	 Press the down arrow key four times.

					     Select Save settings.

5.	 Press DISP/ENTER once.

6.	 Press the Input soft key once.

7.	� Enter “SF2” for the file name.
For the input procedure, see “Entering Values and Characters” on page 17.

					   

8.	 Press DISP/ENTER once. The message “Data are being saved to media” 
appears, and the setup data is saved.

9.	 Press ESC or MENU twice to return to the operation mode screen.

	 On a DX with advanced security (/AS1 option):

	 Press ESC or MENU twice to display a confirmation screen. To return to the 
operation mode screen, select Yes, and press DISP/ENTER once.

Operation complete.

Basic Operation
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Loading the Setup Data
In this example, we will load the setup data “SF2” from the CF card and update the DX 
settings.
This procedure only loads the setup data that the DX uses for setting mode.To load the 
setup data for both setting mode and basic setting mode, press MENU, hold down FUNC 
for 3 s, select the File/Initialize tab > Load settings, and press DISP/ENTER.

1.	 Display the operation mode screen.

					   

2.	 Press MENU once to display the setting menu.

3.	 Press the right arrow key once to select the File tab.

4.	 Press the down arrow key three times.

					   
Select Load settings.

5.	 Press DISP/ENTER once to select the root directory (CF:/).

6.	 Press DISP/ENTER once to display the files in the root directory.

7.	 Select the file SF2 using the up and down arrow keys.

					   

To move to a lower directory
Select the directory, and press 
DISP/ENTER.

To move to a higher directory
Press ESC.

8.	 Press DISP/ENTER once. The message “File is being loaded from media” 
appears, and the setup data is loaded. The DX automatically returns to the 
operation mode screen.

Operation complete.

Basic Operation
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Setting the Input Range and Alarm

Setup Example 1: Temperature Measurement Channel

			 
Type T 
thermocouple Channel 1

0.0 to 200.0°C

DX

Setup Item Description Number in the Figure
Channel Use channel 1. 1
Tag TI-001 2
Sensor Type T thermocouple 3
Input range 0.0 to 200.0°C 4

(1) Input Range
	 Press MENU (switch to the setting mode).
	 Select the Menu tab > Meas channel > Range, Alarm.

			 

1

4
3

(2) Tag
	 Select the Menu tab > Meas channel > Tag, Memory, Delay.

			 
2

Operation complete.



29IM 04L45B01-02EN

Setting the Input Range and Alarm

Setup Example 2: Flow Rate Measurement Channel and Alarm

			 

DX

Flowmeter Channel 2

4 - 20 mA

Convert to 1-5 V with a shunt resistor

Setup Item Description Number in the Figure
Channel Use channel 2. 1
Tag FI-002 2
Input signal 1-5V 3
Input range 0.0 to 500.0 L/H 4
Alarm condition Output an alarm if the measured value is 

less than or equal to 120.0 L/H.
Output destination: Relay contact (I03)

5

(1) Input Range and Alarm
	 Press MENU (switch to the setting mode).
	 Select the Menu tab > Meas channel > Range, Alarm.

			 

1 

5 

4

3

(2) Tag
	 Select the Menu tab > Meas channel > Tag, Memory, Delay.

			 
2

Operation complete.
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Setting the Display

Setup Example 3: Assigning Channels to Groups
In this example, we will assign channels 1 and 2 to group 1.

			 

Channel 1

Group 1

Channel 2

Setup Item Description Number in the Figure
Group Assign channel 1 and 2 to group 1. 1

(1) Group
	 Press MENU (to switch to setting mode) > select the Menu tab > Group set, Trip 

line.

			 

1 

Operation complete.
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Setting the Display

Setup Example 4: Setting the Time Scale
Set the time per division of the trend waveform to 2 minutes.

			 

The sampling interval (the time 
corresponding to 1 dot) is 4 s when the trend 
interval is 2 min.
30 dots × 4 s = 2 min

30 dots/div

Setup Item Description Number in the Figure
Trend interval Set the time per division to 2 minutes.

The waveform is updated at every 4 s.
1

(1) Trend interval
	 Press MENU (to switch to setting mode) > select the Menu tab > Display > Trend/

Save interval.

			 

1

Operation complete.
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Setting the Data Storage

Setup Example 5: Continuously Record Measured Data and Automatically Save
In this example, we will continuously record and save the measured data of channel 1 
and 2.
For the procedure to set the channel, see “Setting the Input Range and Alarm” on page 
28. For the procedure to set groups, see “Setting the Display” on page 30.

	 		
Automatically save to 
the CF card periodically.

Channel 1 Channel 2 
Setup Item Description Number in the Figure
Source channels Channel 1 (TI-001) and channel 2 (FI-002) 1
Data to be recorded Continuously record the display data from the start of the 

measurement.
2

Data storage method Automatically store every 24 hours. 3
Sampling interval 4 seconds. Set using the trend interval.

Sampling interval = (trend interval setting)/30 dots*

* 40 dots when the trend interval is set to 5 or 10 seconds.

4

Data file name Add “sample” to the file name. 5
Example: 000123_sampleYYMMDD_HHMMSS.DAD

↑	 ↑
Sequential number	 Date/Time of the first recorded data

Save Destination  
Directory

DATA-101 6

(1) Data to be Recorded
	 Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the 

basic setting mode).
	 Select the Menu tab > A/D, Memory.

			   2
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(2) Method of Storing to the CF Card (Auto Save ON/OFF)
	 Select the Environment tab > Security, Media save

			   3

(3) Save the Settings
1.	 Press ESC to return to the basic setting menu.
2.	 Press ESC once more.

	The window appears for you to confirm the saving of the settings.

3.	 Select Yes and press DISP/ENTER. The DX returns to the operation mode 
screen.

(4) Channels to Be Recorded
	 Press MENU (switch to the setting mode).
	 Select the Menu tab > Meas channel > Tag, Memory, Delay.

			 

1 

(5) Interval for Saving the Data to the CF Card
	 Select the Menu tab > Display > Trend/Save interval.

			 

4
3

(6) Data File Name
	 Select the Menu tab > Data save > File header, File name.

			   5

Setting the Data Storage
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(7) Save Destination Directory (within the CF Card)
	 Select the Menu tab > Data save > Save directory.

			 

6

Operation complete.

Setting the Data Storage
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Setup Example 6: Saving Measured Data at the Specified Time
Using the settings of Setup Example 5, we will save the measured data once at hour 0 
every day.

			 

DX
Every hour 0

Automatically save 
to the CF card

7 56

1211
10

8 4

2
1

9 3

All settings other than those listed below are the same as Setup Example 5.
Setup Item Description Number in the Figure
Data storage time Save the data once at hour 0 every day. 7
Data storage method Automatically save the measured data at 

the specified time.
8

(1) Setting the Time
	 Press MENU (switch to the setting mode).
	 Select the Menu tab > Timer, Event action > Match time timer.

			 

7 

(2) Specifying the Data Storage
	 Select the Menu tab > Timer, Event action > Event action.

			 

8 

Operation complete.

Setting the Data Storage
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Customizing the Operation

Setup Example 7: Assigning the Screen Image Data Storage Function to the 
USER Key

In this example, we will set the DX so that the displayed screen image data can be saved 
to the CF card by pressing the USER key. This function is called snapshot. The extension 
of snapshot data files is .png.

			 

START USER FUNC ESC MENUSTOP

USER key

Setup Item Description Number in the Figure
Event action Save the screen image data of the DX 

using the USER key. 
1 

(1) Assigning an Action to the USER Key
	 Press MENU (to switch to setting mode) > select the Menu tab > Timer, Event action 

> Event action.

			 

1 

Operation complete.
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Customizing the Operation

Setup Example 8: Registering Frequently Used Screens to the Favorite Key
Up to eight operation mode screens that are frequently used can be registered to the 
Favorite key. This enables you to monitor the operation by using only the Favorite key. 
This feature is convenient when comparing data such as historical trends.

		

Favorite key

Favorite key

Favorite key

Favorite key

Operation mode screens registered to the Favorite key
(example when three screens are registered)

Favorite key

1.	 Display the screen to be registered.

					   

2.	 Press FUNC once to display the FUNC key menu.

3.	 Press the Next soft key to display Favorite regist.

4.	 Press the Favorite regist soft key to display the registration list window.

					   

Show the registration list window.
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5.	 Press the favorite number (1 to 8) soft key.

6.	 Press the Regist soft key.

					   

Show the window for entering the 
display name.

7.	 Enter the screen name.
Select the input position:	 Left and right arrow soft keys
Enter characters:	 Arrow keys and DISP/ENTER
Delete a character:	� Use the arrow keys to select Del and press DISP/ENTER, or 

press the Bs soft key.
Enter the input:	� Use the arrow keys to select ENT and press DISP/ENTER.
Cancel the setting:	 Press ESC before pressing DISP/ENTER.
For the input procedure, see “Entering Values and Characters” on page 17.

8.	 Press DISP/ENTER once.

9.	 Repeat steps 1 to 8 to register up to eight screens.

Operation complete.

Customizing the Operation
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Touch Panel O
perations

Touch Panel Operations

Note
The touch panel is only enabled in operation mode (on the operation screen).

You can use the touch panel to perform operations such as pressing buttons on the 
operation screen and selecting menu and window items.
As an example, this section will explain how to use the touch panel to perform basic DX 
operations.
For details on the screens displayed and on how to configure the settings, see the 
electronic manuals provided on the accompanying CD.
Touch Panel Specifications

Touch Panel Specifications
Item Description
Method Analog resistive-membrane type
Service life 100,000 operations or more
Operation force 0.1 to 2.0 N

CAUTION
Do not push or scrape the touch panel surface with a sharp blade or pointed object. 
Doing so may damage the instrument.

Terminology Used in the Explanation of Touch Panel Operations

Tap This refers to the act of lightly pressing your finger against the 
screen for just a moment.

Hold your finger 
down

This refers to the act of lightly pressing your finger against the 
screen and leaving your finger there.

Screens That You Can Use the Touch Panel to Operate
Operation Screen Description
Historical trend Cursor movement, waveform movement, display mode switching, 

calendar display,  
Sign record initiation, signing

Overview Channel selection
Alarm summary Item selection, item scrolling, sort order, sort item switching
Message summary
Memory summary Item selection, item scrolling, data classification switching, 

additional information window display
Text field
Network information
Historical information

Page switching

Various logs Item scrolling, additional information window display (only the 
operation log)

Multi batch Batch selection
Custom display Value input (communication and Modbus), button operation, 

switch operation (available only in operation mode; not available 
on the builder screen)
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Displaying the Operator Menu
1.	 In operation mode, tap anywhere on the screen other than the status area.

The Operator menu button appears in the status area.

					     1

2.	 Tap the Operator menu button.
The operator menu appears.

					   
Cancel (ESC) button

[Operator menu] button

Tap this button to return to 
the previous display.

2

Operation complete.

	 The following figure shows the operator menu on the trend display.

				  

FUNC key menu 
button

Operation screen menu 
button

Operation screen menu

Cancel (ESC) button

FUNC key menu

Displays the operation screen 
menu

Displays the FUNC key menu

Closes the FUNC key menu

Home button

Registering the Home.

Displays the operation screen that is  registered to 
the button as the Home screen.

The default setting of the Home is the group 1 of the trend display.

1. Displays the operation screen to be registered.
2. Tap the Operator menu button.
3. Tap the FUNC key menu button.

The FUNC key menu appears.

4. Tap the Standard display button on the FUNC key menu.
The display is registered.

	 For the List of Operator Menu Items, see page 104

Touch Panel Operations
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Touch Panel O
perations

Touch Panel Operations

Starting Memory Sampling
1.	 Press START once.

	 On a DX with advanced security (/AS1 option) display the start recording screen*. 
With START selected, press DISP/ENTER once.
	Memory sampling starts.
*	 This is because the Batch function is enabled upon shipment from the factory.

					   

START USER FUNC ESC MENU STOP 

START key 

Memory sampling progress
DISP: Display data
EVENT: Event dataRecording data

Operation complete.

Stopping Memory Sampling
1.	 Press STOP once.

					   
Display the confirmation 
window.

2

2.	 Tap Mem+Math or Memory.

	 Memory:	 Stops memory sampling.

	 Mem+Math:	 Stops memory sampling and computation (option).

	 On models without the computation function (option), the confirmation message 
“Do you want to stop data storage?” appears. Select Yes.

					   
Stop memory sampling.

Operation complete.
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Switching between Operation Screens
The Favorite key ( ) is useful in switching between operation screens.

	 For the procedure to register screens, see “Setup Example 8: Registering Frequently 
Used Screens to the Favorite Key” on page 37.

The following procedure shows how to use the operator menu to switch between 
operation screens. This example will show you how to switch from the trend display to 
the digital display.

1.	 Tap the Operator menu button.

					     1

2.	 Tap the operation screen menu button.

					   

2

3.	 Tap DIGITAL on the operation screen menu.

4.	 Tap one of the groups that are displayed on the menu.

					   
3 4

					   

Group number

Digital display

Operation complete.

Press the down arrow key when the trend, digital, or bar graph is displayed to switch the 
display in the order trend, digital, bar graph, trend, and so on. Press the up arrow key 
to switch the display in reverse order. Press the right arrow key or the left arrow key to 
switch the group.

Touch Panel Operations
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Touch Panel O
perations

Writing the Message “START”
Registering the Word “START” in Message Number 1 (Key operation)

On a DX with advanced security (/AS1 option), this operation is only available when 
memory sampling is stopped.

1.	 Press MENU (to switch to setting mode), and select the Menu tab > Message, 
Comment > Message > DISP/ENTER.

2.	 Press 1-10 soft key.

	 The message, “Message numbers 1-10 can also be used for free message” appears. Press 
DISP/ENTER.

3.	 Press the down arrow key. With message 1 selected, press the Input soft key.
Enter “START”.

					   

Show the message 
registration window.

	 Select the digit:	 Left and right arrow keys

	 Enter characters:	 Character/Number input keys

	 Delete a character:	 Del soft key or Bs soft key

	 Cancel the setting:	 Press ESC before pressing DISP/ENTER.

	 For the input procedure, see “Entering Values and Characters” on page 16.

4.	 Press DISP/ENTER.

					   

5.	 Press ESC three times or MENU twice to return to the operation mode screen.

	 On a DX with advanced security (/AS1 option):

	 Press ESC three times or MENU twice to display a confirmation screen. To return 
to the operation mode screen, select Yes, and press DISP/ENTER.

Operation complete.

Touch Panel Operations
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Writing Message Number 1 “START”
This operation can only be carried out while memory sample is in progress. The message 
is displayed on the trend display. Show the trend display first.

1.	 Tap the Operator menu button.

					     1

2.	 Tap the Message button
The Message list window is displayed.

					   
2

3.	 Tap the message that you want to write (“START”).

4.	 Tap the Write button.

					   

Displays the 10 previous 
messages
Displays the 10 next 
messages

ESC button

Write button

3

4

Operation complete.

Touch Panel Operations
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Touch Panel O
perations

Writing a Free Message

1.	 Tap the Operator menu button.

					     1

2.	 Tap the Free message button.
The Message list window is displayed.

					   
2

3.	 Tap the cell in which you want to enter the message.
The message input window is displayed.
ESC button

					   

ESC button

3

4.	 Enter the message, and then tap the ENT button.
This writes the entered message.

					   

4

Operation complete.

Touch Panel Operations
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Displaying Previously Measured Data (Historical trend display)

Displaying the Historical Trend from the Trend Display
1.	 Tap the Operator menu button.

					     1

2.	 Tap the Trend history button or the operation screen menu button.

					   

Operator menu on the trend display

2

2

	 If you have tapped the Trend history button, the procedure is finished.
The historical trend is displayed on the trend display group that was displayed in step 1.

3.	 Tap Trend history on the operation screen menu.

4.	 Tap one of the groups that are displayed on the menu.

					     3 4

					   

The waveform of the channel 
which you tapped is displayed 
on the top.

Operation complete.

Touch Panel Operations
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Touch Panel O
perations

Returning to the Display That Was Shown before the Historical Trend
1.	 Tap the Operator menu button.

					     1

2.	 Tap the Exit history button.

					   

2

Operation complete.

Expanding and Reducing the Time Axis

				  

Zoom buttons

Tap this button to expand the time axis.

Tap this button to reduce the time axis.

Moving the Cursor

				  

Hold your finger down in the waveform display 
range to move the cursor.

Tap the waveform display range to move the 
cursor to the position that you tapped.

Moves the cursor to 
the down (left) by 10 dots

Moves the cursor to 
the down (left) by 2 divisions

Moves the cursor to 
the up (right) by 10 dots
Moves the cursor to 
the up (right) by 2 divisions

Touch Panel Operations
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Specifying the Display Range
Items in parentheses are for the vertical trend display.

1.	 Tap the Operator menu button.

					     1

2.	 Tap the All data display button.

					     2

The waveform of the entire data range is displayed at the top (right) section of the historical 
trend display.

3.	 On the all data display, tap the area that you want to view.
The frame that indicates the display range moves to the position that you tapped.

					   

All data display

3

Frame that indicates 
the display range

4.	 Tap somewhere in the waveform display range outside of the all data display.
The specified range is displayed.

					   

4

Operation complete.

Touch Panel Operations
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Touch Panel O
perations

Displaying the Measured Data from a Specified Date and Time
You can search for measured data at the specified date and time and display the results. 
You can search the display data or event data in the DX internal memory.

1.	 Tap the Operator menu button.

					     1

2.	 Tap the Data search button.
The calendar is displayed.

					     2

3.	 Tap the date that you want to display.
If the selected date has display data and event data, the data type selection window is 
displayed.

					   

Changes the displayed year

Red square: Indicates the selected day
D: Indicates that there is display data

Changes the displayed year

Changes the displayed month

Changes the displayed month

E: Indicates that there is event data
3

4.	 Tap Display or Event.

5.	 Tap the OK button.
The Input Search Time window is displayed.

					   

5

4

Touch Panel Operations
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6.	 Tap the number buttons to enter the time, and then tap the OK button.
The screen that corresponds to the entered search time is displayed.

					   
Arrow buttons

Number buttons

These buttons move the cursor 
in the corresponding direction.

Use these buttons to enter the time.

Closes this window and returns 
to the previous screen6

Operation complete.

Writing an Additional Message or an Additional Free Message
1.	 Tap the position where you want to write the message.

The cursor moves to the tapped position.

					     1

2

2.	 Tap the Operator menu button.

3.	 Tap the Add message or Add free message button.
The Message list window is displayed.

					   

33

	 For the procedure for writing additional messages, see “Writing the Message ‘START’“ 
on page 43.

	 For the procedure for writing additional free messages, see “Writing a Free Message” 
on page 45.

Operation complete.

Touch Panel Operations



51IM 04L45B01-02EN

Touch Panel O
perations

Operating Other Screens
Overview Screen

•	 The cursor (the white frame) moves to the position that you tap (for selecting 
channels).

•	 When you tap the selected channel, the cursor turns off.

				  

Alarm Summary, Message Summary, and Memory Summary Screens

				  

The cursor moves to the entry 
that you tap.

Tap an item in the title area 
to sort the list by that item.

Hold your finger down to scroll 
through the data.

Cursor
Sort symbol

Moves the cursor 
a half page up

Moves the cursor 
a half page down

Moves the cursor 
two lines up

Moves the cursor 
two lines down

Ascending order
Descending order

Tap one of these items to 
switch the displayed data.

	 On DXs with the /AS1 advanced security option, if Add. info is displayed in the lower 
left of the memory summary screen, tap Add. info to display the signature information 
screen.

Touch Panel Operations
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Calibrating the Touch Panel and Checking the Calibration

Calibrating the Touch Panel
1.	 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to 

basic setting mode), select the File/Initialize tab > Touch panel calibration > 
Execute, and press DISP/ENTER.

2.	 Follow the instructions on the screen, and touch the center of the circle that is 
indicated by an arrow.
When you have performed this operation on five points, the touch panel is calibrated.

					   

1 2

3 4

5

3.	 Press ESC three times.
A confirmation window is displayed.

4.	 Select Yes, and press DISP/ENTER.
The DX1000T returns to the operation mode screen.

Checking the Touch Panel Calibration
1.	 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to 

basic setting mode), select the File/Initialize tab > Touch panel calibration > 
Check, and press DISP/ENTER.

2.	 Touch anywhere on the screen outside of the status area.
If a plus sign is displayed in green at the position that you touched the screen, the touch 
panel has been calibrated correctly.
If the plus sign is displayed away from the position that you touched the screen, recalibrate 
the touch panel.

					   

OK No good

3.	 Press ESC three times.
A confirmation window is displayed.

4.	 Select Yes, and press DISP/ENTER.
The DX1000T returns to the operation mode screen.

Touch Panel Operations
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Touch Panel O
perations

Preventing Touch Panel Operations (Locking the touch panel)

This section explains the settings and the procedure that are used to prevent touch panel 
operations.
Locking the Touch Panel

Setup Screen
	 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Security, Media save

			 

When Touch panel is set to Password

Setup Items

•	 Security > Touch panel
Setting Description
Off Touch panel operations are not disabled.
On Touch panel operations are disabled.
Password Touch panel operations are disabled.

The password is used to unlock the touch panel.
(The password is up to eight alphanumeric characters.) The password is 
displayed as “********.”

Procedure

Locking the Touch Panel
1.	 Tap the FUNC key menu button on the operator menu.

The FUNC key menu appears.

2.	 Tap the TouchPnl Lock button on the FUNC key menu.
This locks the touch panel operations.

Unlocking the Touch Panel
1.	 In operation mode, press FUNC.

The FUNC key menu appears.

2.	 Press the TouchPnl Lock soft key.
If Security > Touch panel is set to On, these steps are sufficient to unlock the touch panel.
If Security > Touch panel is set to Password, a window for entering the password is 
displayed. You can use the touch panel to operate this window.

3.	 Enter the password, and then tap ENT.
This unlocks the touch panel.

Touch Panel Operations
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Setting Command
	 For details on the setting commands, see the DX1000/DX1000N/DX2000 
Communication Interface User’s Manual, IM 04L41B01-17E.

Setting Command

SM Sets the custom menu

Function menu setting
p1 Type (FUNC)
p2 and up Menu items to display

The selected function is displayed in the specified order on the menu. 
Menus that are not specified are not displayed.
TOUCHPANEL_LOCK Locks and unlocks the touch panel

Touch Panel Operations
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Connecting to an Ethernet Network

Setup Example 9: Monitoring the DX on a PC Browser
In this example, we will connect the PC and the DX via hub in a one-to-one relationship 
and display and monitor the DX screen on a browser on the PC.

			 
DX

PC

Ethernet
HUB

	 DX
Setup Item Description Number in the Figure
IP address 192.168.1.101 1
Subnet mask 255.255.255.0
Web server function Monitor from a Web browser on the PC 

using operator page.
2 

Access to the DX Display the Web page and do not set 
access privileges.

3

	 PC
Setup Item Description Number in the Figure
IP address 192.168.1.100 4
Subnet mask 255.255.255.0

(1) IP Address of the DX
	 Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the 

basic setting mode).
	 Select the Menu tab > Communication (Ethernet) > IP-address.

			 
1
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(2) Enabling the Web Server Function on the DX
	 Select the Menu tab > Communication (Ethernet) > Server > Server.

			 

2 

(3) Display the DX Screen on the PC
	 Select the Menu tab > Communication (Ethernet) > Web page.

			 

2

3

(4) Save the Settings
1.	 Press ESC twice to return to the basic setting menu.

2.	 Press ESC once more.
	The window appears for you to confirm the saving of the settings.

3.	 Select Yes and press DISP/ENTER.
	The DX returns to the operation mode screen.

(5) Setting the PC
	 Set the IP address and subnet mask on the PC.

			 

4

Connecting to an Ethernet Network
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(6) Checking the Connection
	 Send the command below from the PC and check that a correct response is returned.
	 Send
	 >ping 192.168.1.101

	 Response example
	 >Reply from 192.168.1.101: bytes=32 time<10ms TTL=255

(7) Displaying the DX Screen on the Browser
1.	 Start the browser on the PC.

2.	 Enter the following URL.
http://192.168.1.101/operator.htm

3.	 Check that the DX screen appears.

					   

Operation complete.

Connecting to an Ethernet Network
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Setup Example 10: Automatically Transferring the Measured Data File to an FTP 
Server

In this example, we will configure the DX so that the measured data is automatically 
transferred to an FTP server on the network when the measured data is automatically 
saved to the CF card. To automatically transfer the measured data files and report files, 
the auto saving of the measured data must be configured in advance (“Data storage 
method” of Example 5).
This example assumes that the following network environment is used: DHCP enabled, 
automatically obtain the DNS server information, and automatically register the DX host 
name to the DNS server. Set the parameters according to your network environment.

		

DX

Measurement input

Ethernet
Automatic data transfer to an FTP server

CF card

FTP server

Internal
memory

Setup Item Description Number in the Figure
Host name DAQSTATION1 1
Obtain the IP address Obtain automatically (DHCP) 2
Type of data to be transferred Acquired measured data 3
FTP server Server name abcdefg.co.jp 4

Port number 21
Login name ftpuser1
Password a1234

(1) IP Address of the DX
	 Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the 

basic setting mode).
	 Select the Menu tab > Communication (Ethernet) > IP-address.

			 

2
Automatically obtain the DNS server information.
Automatically register the DX host name to the 
DNS server.

(2) Host Settings Address of the DX
	 Select the Menu tab > Communication (Ethernet) > Host settings.

			 

1

Connecting to an Ethernet Network
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(3) Data to Be Transferred to the FTP Server
	 Select the Menu tab > Communication (Ethernet) > FTP client > FTP transfer file.

			 

3 

(4) Connected setting FTP Server
	 Select the Menu tab > Communication (Ethernet) > FTP client > FTP connection.

			 

4 

(5) Save the Settings
1.	 Press ESC three times to return to the basic setting menu.

2.	 Press ESC once more.
	The window appears for you to confirm the saving of the settings.

3.	 Select Yes and press DISP/ENTER.
	The DX returns to the operation mode screen.

Operation complete.

Executing a File Transfer Test
1.	 Press FUNC once to display the FUNC key menu.

2.	 Press the Next soft key until FTP test is displayed, and then press the FTP test 
soft key.

					   

FTP test soft key

3.	 Press the Primary soft key. The messages “FTP test is being executed” and 
“Execution is complete” appear and the test file (FTP_TEST.TXT) is sent to the 
FTP server.

Operation complete.

Transferring the Data Files
When you start memory sampling, the measured data file is transferred to the FTP server 
when the data is saved to the CF card.

Connecting to an Ethernet Network
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Using DAQSTANDARD

Displaying the Measured Data on DAQSTANDARD
In this example, we will display the measured data using the accompanying software 
program, DAQSTANDARD.
1.	 Insert the CF card containing the measured data file into the PC that has 

DAQSTANDARD installed.
2.	 Start DAQSTANDARD Viewer.

					   

3.	 From the File menu, choose Open.
4.	 In the Open dialog box, select the desired file, and click Open.
	 The data is displayed.

					   

Operation complete.
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DX1000T Settings
For an explanation of the settings, see the DXA120 DAQSTANDARD Hardware Setup 
User’s Manual, IM 04L41B01-64EN.
In the above manual, read “DX1000” as “DX1000T.” Only the settings that are different 
from the DX1000 are listed below.

System Configuration Dialog Box
	 On the DXAdvanced tab, set the model to DX1000T.

			 

Basic setting mode > Environment tab > Detail Setting
•	 Touch panel

OFF The touch panel is not locked.
ON The touch panel is locked.
Password The touch panel is locked, and a password is required to unlock it.

•	 Password
	 This is the password that is used to unlock the touch panel. The password is displayed 

as “********.” (The password is up to eight characters.)
	 When Touch panel is set to Password, this setting is enabled.

General setting > Menu Customize > Function menu
	 TouchPnl Lock is one of the available selections.

Using SAQSTANDARD
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Installation and Wiring

Installation Location
Install the DX indoors in a location that meets the following conditions.
•	 Instrumentation Panel
	 The DX is designed to be installed in an instrumentation panel except for the desktop 

type.
•	 Well-Ventilated Location
	 To prevent overheating, install the DX in a well-ventilated location. For the panel cut 

dimensions when arranging multiple DXs, see the page 51. Follow the panel cut 
dimensions providing adequate space between instruments when other instruments 
are arranged on the panel. For the desktop type, we recommend that a space of at 
least 50 mm be provided around the left, right, top, and rear panels of the DX.

•	 Minimum Mechanical Vibrations
	 Choose an installation location with the minimum mechanical vibration. Installing the 

DX in a location with large mechanical vibration not only causes adverse effects on 
the mechanism but also may hinder normal recording.

•	 Horizontal
	 Install the DX horizontally (However, the DX can be inclined up to 30 degrees 

backwards for panel mounting).

Note
	 Condensation may occur if the DX is moved to another place where the ambient 

temperature is higher, or if the temperature changes rapidly. In addition, measurement 
errors will result when using thermocouples. If this happens, let the DX adjust to the new 
environment for at least one hour before using it.

Do not install the DX in the following places.
•	 Outdoors
•	 In Direct Sunlight or Near Heat Sources
	 Install the DX in a place with small temperature fluctuations near room temperature 

(23°C). Placing the DX in direct sunlight or near heat appliances can cause adverse 
effects on the internal circuitry.

•	� Where an Excessive Amount of Soot, Steam, Moisture, Dust, or 
Corrosive Gases Are Present

	 Soot, steam, moisture, dust, and corrosive gases will adversely affect the DX. Avoid 
such locations.

•	 Near Strong Magnetic Field Sources
	 Do not bring magnets or instruments that produce electromagnetic fields close to the 

DX. Operating the DX in strong magnetic fields can cause errors in the measurements.
•	 Where the Viewing of the Display Is Poor
	 The DX uses a TFT color LCD for the display. Therefore, viewing of the display from 

an extreme angle is difficult. Install the DX so that the user can view the display from 
the front.
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Installation Procedure
Installation Procedure (Panel Mount Type)

Use a steel panel of thickness 2 mm to 26 mm.

1.	 Insert DX from the front of the panel.

2.	 Mount the DX to the panel using the mounting brackets that come with the 
package as shown in the figure below.

•	 Use two brackets to support the top and bottom or the left and right sides of 
the case (remove the seal that is covering the holes for the mounting brackets 
beforehand).

•	 The proper torque for tightening the mounting screws is 0.7 to 0.9 N•m.
•	 Mount the DX to the rack according to the procedure below.

•  First, attach the two mounting brackets and temporarily fasten the 
attachment screws.

•  Next, fix the DX in place by tightening the attachment screws with the 
appropriate torque. When the DX is approximately perpendicular to the 
panel as you fasten the screws, press the mounting bracket against the 
case so that they are in contact with each other.

	 CAUTION
•	 Tightening the screws too much can deform the case or damage the bracket.
•	 Be careful not to insert foreign objects or tools through the holes for the 

mounting brackets in the case.

Panel Mounting Diagram

		

Screw temporarily Fixed 

Front 

Panel 

Panel 
Mounting  
brackets Mounting  

brackets Torque driver 
(flat blade) 

Attachment screw 

DX case 

In contact with  
each other 

(The figure shows the case when the mounting brackets  
are used on the top and bottom of the case.) 

Attachment  
screw 

Note
To achieve sufficient dust and water proof performance, mount the DX in the middle of the 
panel cut out.

Installation (Desktop Type (/H5[ ] Option)
The front (leg) stand can be pulled out.

CAUTION
	� On the desktop type, do not apply force to the DX when the front leg (stand) is 

out. This can break the front leg.
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External Dimensions and Panel Cut Dimensions
Unit: mm (approx. inch) 
Unless otherwise specified, tolerance is ±3%  
(however, tolerance is   0.3 mm when below 10 mm). 

Panel mount type 

Desktop type (/H5[ ] Option) 

14
4.

3 
(5

.6
8)

 

14
3 

(5
.6

3)
 

40
 

(1
.5

7)
 

15
 

(0
.5

9)
 

14
.4

 
(0

.5
7)

 
39

.3
 

(1
.5

5)
 

13
8.

8 
(5

.4
6)

 

MAX  252.5 (99.4) (/H2 or /PM1) 144.3 
(5.68) 

Panel cut dimensions 

137 
(5.39) 

+2 
0 

137 
(5.39) 

(5.39) 

+2 
0 

137 
(5.39) 

(6.89) 

(6.89) 

+2 
0 

175 MIN 

175 MIN 

L +2 
0 

L +2 
0 

L +2 
0 

137 +2 
0 

2 
3 
4 
5 
6 
7 
8 
9 

10 
n 

282 (11.10) 
426 (16.77) 
570 (22.44) 
714 (28.11) 
858 (33.78) 
1002 (39.45) 
1146 (45.12) 
1290 (50.79) 
1434 (56.46) 
(144×n)-6 

Side-by-Side Mounting  
(vertically, max. 3 units) 

Side-by-Side Mounting  
(horizontally) 

Single-Unit  
Mounting 

Units 

(Dimensions after attaching  
the mounting bracket) 

(Dimensions before attaching  
the mounting bracket) 

13
6.

5 
(5

.3
7)

 +0
.4

 
0 

13
6.

5 

15
1.

5 
(5

.9
6)

 
14

4 
(5

.6
7)

 
99

.9
 (3

.9
3)

41
.4

 (1
.6

39

7.
5 

9.
4 

(0
.3

7)
 

(5
.3

7)
 

(0
.3

0)
 

+0
.4

 
0 

103.4 (4.07)

40.9 (1.61)

151.5 (5.96) 
24.0 
(0.94) 

224.1 (8.82)

MAX 228.5 (9.00) (/H2 or /PM1)

170.5 (6.71)

MAX 28.0 (1.10) 
(/KB1 or /KB2) 

144 (5.67) 2 to 26 
(Allowable panel thickness) 

± 
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Input Signal Wiring

	 WARNING
•	� To prevent electric shock while wiring, ensure that the power supply source is 

turned OFF.

CAUTION
•	� If a strong tension is applied to the cable wired to the DX, the terminals of the DX 

and/or the cable can be damaged. In order to prevent tension from being applied 
directly on the terminals, fasten all wiring cables to the rear of the mounting 
panel.

•	 To prevent fire, use signal wires having a temperature rating of 70°C or more.
•	� Do not apply a voltage exceeding the following value to the input terminals. 

Otherwise, damage to the DX may result.
	 •	 Maximum input voltage: ±60 VDC
	 •	� Maximum common mode voltage: ±60 VDC (under measurement category II 

conditions)
•	 The DX is a product of installation category II.

Precautions to Be Taken While Wiring
Take the following precautions when wring the input signal cables.
When using a screw terminal, we recommend that you use a crimp-on lug 
with an insulation sleeve (designed for 4-mm screws).

			   Crimp-on lug with insulation sleeves (for 4 mm screws)

When using a clamp terminal (/H2), we recommend that you use the 
following kind of cable:
•	 Conductive cross-sectional area: 0.08 mm2 to 1.5 mm2 (AWG 28 to 16)
•	 Length of the stripped section of the wire: Approx. 7 mm
Take measures to prevent noise from entering the measurement circuit.
•	 Move the measurement circuit away from the power cable (power circuit) and ground 

circuit.
•	 It is desirable that the object being measured does not generate noise. However, if 

this is unavoidable, isolate the measurement circuit from the object. Also, ground the 
object being measured.

•	 Shielded wires should be used to minimize noise caused by electrostatic induction. 
Connect the shield to the ground terminal of the DX as necessary (make sure you are 
not grounding at two points).

•	 To minimize noise caused by electromagnetic induction, twist the measurement circuit 
wires at short, equal intervals.

•	 Make sure to earth ground the protective ground terminal through minimum resistance 
(less than 100 Ω).

When using internal reference junction compensation on the thermocouple 
input, take measures to stabilize the temperature at the input terminal.
•	 Always use the terminal cover.
•	 Do not use thick wires which may cause large heat dissipation (cross sectional area of 

0.5 mm2 or less recommended).
•	 Make sure that the ambient temperature remains reasonably stable. Large 

temperature fluctuations can occur if a nearby fan turns ON or OFF.
Connecting the input wires in parallel with other devices can cause signal 
degradation, affecting all connected devices. If you need to make a parallel 
connection, then
•	 Turn the burnout detection function OFF.
•	 Ground the instruments to the same point.
•	 Do not turn ON or OFF another instrument during operation. This can have adverse 

effects on the other instruments.
•	 RTDs cannot be wired in parallel.
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Wiring Procedure
A terminal cover is screwed in place on the measuring input terminal block on the rear 
panel. A label indicating the terminal arrangement is affixed to the cover.

1.	 Turn OFF the DX and remove the terminal cover.

2.	 Connect the signal wires to the terminals.

Recommended torque for 
tightening the screws

Screw terminals 0.9 to 1.0 N•m
Clampted terminals 0.22 to 0.25 N•m

3.	 Replace the terminal cover and fasten it with screws. The proper torque for 
tightening the screws is 0.6 N•m.

Note
Input signal wires of diameter less than or equal to 0.3 mm may not be secured firmly for 
clamped terminals (/H2). Fold over the conducting section of the wire, for example, to make 
sure that the wire is securely connected to the clamped terminal.

Arrangement of the Input Terminals

			 

Input terminal block

	

+/A 
/b 

CH1 
CH2 

CH3 
CH4 

CH1 
CH2 

CH3 
CH4 

CH5 
CH6 

-/B 

+/A 
/b 

-/B 

CH1 

CH2 

CH5 CH3 CH1 

CH6 CH4 CH2 

CH3 CH1 

CH4 CH2 

/b 
+/A 
-/B 

/b 
+/A 
-/B 

/b 
+/A 
-/B +/A 

/b 
CH1 

CH2 

-/B 

Screw terminal 

Input terminal block of 
the DX1002T

Input terminal block of 
the DX1004T

Input terminal block of 
the DX1006T

Input terminal block of 
the DX1012T

Clamp terminal 

CH1 
CH2 

CH3 
CH4 

CH5 
CH6 

CH7 
CH8 

CH9 CH11 
CH10 CH12 

+/A 
/b 

-/B 

CH5 CH3 CH1 

CH6 CH4 CH2 

CH9 CH7 

CH10 

CH11 

CH12 CH8 

/b 
+/A 
-/B 
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Wiring Screw Terminals

–

+ +

–
DC voltage input

TC inputDC voltage input/DI (ON/OFF) input

RTD input DC current input

DC current input

Shunt resistor
Example: For 4 to 20 mA input, use a 
 shunt resistor of 250 Ω 

–

+

–

+

–

+

A

B

b

Lead wire resistance per wire of 
10 Ω or less. Make the resistance 
of the three wires equal.

A

b
B

Compensating leadwire

±0.1%.

Wiring Clamped Terminals

CAUTION
As of August, 2007, the direction of the terminal blocks for the clamp input terminals  
(/H2 option) has changed. To use clamp input terminal blocks wired for use with 
previous YOKOGAWA recorders, rewire them to match the DX.

Remove the terminal block
Hold both ends of the terminal 
block and pull straight.

Input signal wire
First, loosen the screw at the front using a flat-blade 
screwdriver.  Insert the input signal wire into the slit on the 
left side of the terminal block, and fasten the screw at the front.

Recommended wire size
0.08 to 1.5 mm2 (AWG 28 to 16)

Recommended 
length of stripped 
wire: 7 mm

Connect the wires

Flat-blade 
screwdriver

Connect the terminal block
Hold both ends of the terminal block, 
align with the connector on the DX 
side, and push the terminal block into 
the connector.

Note
RTD input terminals A and B are isolated on each channel. Terminal b is shorted internally 
across all channels. However, terminal b is also isolated on each channel on models with the  
/N1 option (Cu10, Cu25 RTD input/3 leg isolated RTD) and /N2 option (3 leg isolated RTD).
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Optional Terminal Wiring

	 WARNING
•	 To prevent electric shock while wiring, ensure that the power supply source is 

turned OFF.
•	 If a voltage of more than 30 VAC or 60 VDC is to be applied to the output 

terminals, use ring-tongue crimp-on lugs with insulation sleeves on all terminals 
to prevent the wires from slipping out when the screws become loose. 
Furthermore, use double-insulated wires (dielectric strength of 2300 VAC or 
more) for the signal wires on which a voltage of more than 30 VAC or 60 VDC is 
to be applied. For all other wires, use basic insulated wires (dielectric strength of 
1390 VAC). To prevent electric shock, attach the terminal cover after wiring and 
make sure not to touch the terminals.

CAUTION
•	 Use the following circuit voltage for the connection to the alarm/FAIL/status 

output terminal.
•	 When the connection is to Mains Circuits (primary AC power source circuits):	

		  150 V or less
•	 When the connection is to circuits derived from Mains Circuits (secondary 

circuits):	 250 V or less
	 (Mains Circuits voltage is less than 300 V, and connection must be used by 

isolation transformer.)
•	 To prevent fire, use signal wires having a temperature rating of 70°C or more.
•	 If a strong tension is applied to the cable wired to the DX, the terminals of the DX 

and/or the cable can be damaged. In order to prevent tension from being applied 
directly on the terminals, fasten all wiring cables to the rear of the mounting 
panel.

•	 Do not short the transmitter power supply output terminal or apply external 
voltage to it. If you do, the DX may malfunction.

•	 When using the transmitter power supply output terminal, do not use current 
that exceeds the maximum output current (25 mADC). If you do, the DX may 
malfunction.

Note
For remote control wiring, use shielded wires to reduce noise. Connect the shield to the 
functional ground terminal or the ground terminal of the DX.

Precautions to Be Taken While Wiring
It is recommended that crimp-on lug with insulation sleeves (designed 
for 4-mm screws) be used when connecting wires to the optional input 
terminals.

			   Crimp-on lug with insulation sleeves (for 4-mm screws)

Wiring Procedure
As shown in the figure on next page, the optional terminal block is located on the rear 
panel. The optional terminal block is provided on the DX when an option that requires 
input/output is installed such as the alarm output relay (/A[ ] option), FAIL/status output 
relay (/F1 option), and remote control function (/R1 option), etc. A terminal cover is 
screwed in place on the measuring input terminal block. A label indicating the terminal 
arrangement is affixed to the cover.

1.	 Turn OFF the DX and remove the terminal cover.

2.	 Connect the signal wires to the terminals. The recommended torque for tightening 
the screws is 0.9 to 1.0 N•m

3.	 Replace the terminal cover and fasten it with screws. The proper torque for 
tightening the screws is 0.6 N•m.
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Arrangement of the Optional Terminals

		
Optional terminal block

02 0104 03

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

02 0104 0306 05

C 

1 

2 8 

7 

6 

5 

4 

3 C 

1 

2 8 

7 

6 

5 

4 

3 C 

1 

2 8 

7 

6 

5 

4 

3 

C 

1 

2 8 

7 

6 

5 

4 

3 

C 

1 

2 8 

7 

6 

5 

4 

3 

NC 

NC: Normally closed
C: Common
NO: Normally opened
See page 58.

C 

NO 

NC 

C 

NO 

NC

02 01

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

C 

1 

2 8 

7 

6 

5 

4 

3 NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

/A1 /A2 /A3

/A1/R1 /A2/R1 /A3/R1

/R1 /A1 /F1 /A2 /F1 

/F1 /A1 /F1 /R1 /A2 /F1 /R1 

Symbols such as “NC”: Terminal functions
Alarm output, FAIL, Status

1 to 8: Terminal number
C: Common
See page 58.

Remote control input

A terminal that is not used. (With a screw)

A terminal that is not used. (Without screw)

Alarm 
output

Alarm 
output

02 01

Alarm 
output

Remote
control
input

02 0104 03

Alarm 
output

Remote
control
input

Remote
control
input

02 01

Alarm 
outputFAIL

FAIL

02 0102 01

Alarm 
output

Remote
control
inputFAIL

(To next page)

H and L: See page 58.
Pulse input

+ and –: See page 58.
Transmitter power supply

Alarm 
output

02 0104 0306 05 02 0104 0306 05

Alarm 
output

Remote
control
input

02 0104 03

Alarm 
output

FAIL

02 0104 03

Alarm 
output

Remote
control
inputFAIL

Status Status 

Status Status Status 
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NC 

C 

NO 

NC 

C 

NO 

Pulse  
input 

Pulse  
input 

02 01 04 03 

NC 

C 

NO 

NC 

C 

NO 

02 01 

C H 

L 

H 

L 

H 

L 1 

2 5 

4 

3 

Alarm  
output 

Alarm  
output 

Alarm  
output 

Alarm  
output 

Alarm  
output 

NC 

C 

NO 

NC 

C 

NO 

02 7 6 8 

02 01 

C H 

L 

H 

L 

H 

L 1 

2 5 

4 

3 NC 

C 

NO 

NC 

C 

NO 

02 7 6 8 

C H 

L 

H 

L 

H 

L 1 

2 5 

4 

3 

7 6 8 

C 

1 

2 8 

7 

6 

5 

4 

3 

Remote 
control 
input 

Remote 
control 
input 

Pulse  
input 

Remote 
control 
input 

Pulse  
input 

Remote 
control 
input 

Pulse  
input 

Remote 
control 
input 

Remote 
control 
input 

Remote 
control 
input 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

FAIL 

FAIL FAIL 

/F1 /R1 /A1 /PM1 /A2 /PM1 

/A1 /F1 /PM1 /PM1 /F1 /PM1 

/A1 /TPS2 /A1 /R1 /TPS2 /TPS4 

/TPS2 /R1 /TPS2 /R1 /TPS4 

02 01 

C 

1 

2 8 

7 

6 

5 

4 

3 

C 

1 

2 8 

7 

6 

5 

4 

3 C 

1 

2 8 

7 

6 

5 

4 

3 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

NC 

C 

NO 

02 01 

C 

+ + 
- - 

+ + 
- 

+ 
- 

+ 
- - 

02 01 

NC 

C 

NO 

NC 

C 

NO 

02 01 

+ + 
- - 

H 

L 

H 

L 

H 

L 1 

2 5 

4 

3 

+ + 
- 

+ 
- 

+ 
- - 

Transmitter  
power  
supply 

Transmitter  
power  
supply 

Transmitter  
power  
supply 

Transmitter  
power  
supply 

Transmitter  
power  
supply 

Transmitter  
power  
supply 

+ + 
- - 

7 6 8 

C H 

L 

H 

L 

H 

L 1 

2 5 

4 

3 

7 6 8 

+ + 
- - 

(From previous page) 

Remote 
control 
input 

Remote 
control 
input 

Status 

Status Status 
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Alarm Output Terminal (/A1, /A2, and /A3), FAIL Output Terminal, and Status 
Output Terminal (/F1)

C
NC

NO

Output format: Relay contact
Contact rating: 250 VAC (50/60 Hz)/3 A, 
 250 VDC/0.1 A (for resistor load)
Withstand voltage: 1600 VAC at 50/60 Hz for one 
 minute (between output terminals 
 and the ground terminal)

NO C NC NO C NC NO C NC

NO C NC NO C NC NO C NC

FAIL 
output
(/F1) During normal 

operation
When a failure 

occurs
When power is 

turned OFF

During normal 
operation

When specified 
status occurs

When power is 
turned OFF

Other 
output
(/F1)

Remote Control Input Terminal (/R1)

C C 
1 

1~ 8 

2 

3 
4 
5 

6 
7 
8 

• Transistor input (open collector) Internal circuit • Relay contact input  
 (voltage-free contact) 

C 
1 
2 

3 
4 
5 

6 
7 
8 

Withstand voltage: 1000 VDC for one minute between input terminals and the ground terminal

Input format: 
 Photocoupler isolation 
 Shared common (C) 
Allowable input voltage:  
5 VDC 

5 V Contact closed at 200 Ω or less
Contact open at 100 kΩ or greater

ON voltage: 0.5 V or less (30 mADC) 
Leakage current when turned OFF: 
 0.25 mA or less 

Pulse Input Terminal (/PM1)

H 
L 

H 
L H 

L 
H 
L 

H 
L 

H 
L 

H 
8 7 6 6 7 8 

L 

Withstand voltage: 1000 VDC for one minute between input terminals and the ground terminal

Input format: 
 Photocoupler isolation 
 Shared common (L) 
Allowable input voltage:  
 

5 V 
Internal circuit •Transistor input (open collector) • Relay contact input  

 (voltage-free contact) 
Contact closed at 200 Ω or less
Contact open at 100 kΩ or greater

ON voltage: 0.5 V or less (30 mADC) 
Leakage current when turned OFF: 
 0.25 mA or less 

30 VDC 

24 VDC Transmitter Power Supply Output Terminal (/TPS2 and /TPS4)
Connect the DX to the transmitter as shown below.

–

+

+

–

Transmitter

CurrentDX

Transmitter power 
supply output terminal

Input terminal

Shunt resistor: 250 Ω

To reduce noise, use a shielded cable for wiring.
Connect the shield to the functional ground
terminal or the ground terminal of the DX.

Note

Serial Interface
Connecting to the RS-232 Connector (/C2)

2 1 3 4 5

6 7 98
(male)

2 RD (Received Data):  Received data from the PC. Input signal to the DX.
3 SD (Send Data):  Transmitted data to the PC. Output signal from the DX.
5 SG (Signal Ground): Signal ground.
7 RS (Request to Send): Handshaking signal when receiving data from the PC. Output signal 
     from the DX.
8 CS (Clear to Send): Handshaking signal when transmitting data to the PC. Input signal to 
     the DX.
* Pins 1, 4, 6, and 9 are not used.

Connecting to the PROFIBUS-DP Connector (/CP1)
 RxD/TxD-P: Positive data input/output.
  CNTR-P: RTS (needed when using a repeater).
  DGND: Ground.
  VP +5V: +5 V.
  RxD/TxD-N: Negative data input/output.
* Pins 1, 2, 7, and 9 are not used.
** The DX does not have a built-in terminator. If you need to terminate the cable at the DX, 
     use a terminated connector.

5 4 3 2 1

9 8 7 6
(female)

3
4
5
6
8
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Connecting to the RS-422/485 (/C3)

	

FG (Frame Ground)  Frame ground of the DX.
SG (Signal Ground)  Signal ground.
SDB (Send Data B)  Send data B (+).
SDA (Send Data A)  Send data A (–).
RDB (Received Data B)  Receive data B (+).
RDA (Received Data A)  Receive data A (–).FG SG SDB SDA RDB RDA

Two-wire system

FG SG SDB SDA RDB RDA

Electric potential of the shield

Four-wire system

Shield

Recommended length of stripped wire: 9 mm.  Recommended tightening torque: 0.4-0.5 N•m

Cable
There are two types of cables available, the four-wire cable and the two-wire cable (used only for the 
Modbus protocol).  The cable should meet the following specifications.
• Type: Shielded twisted pair cable: 3 pairs 24 AWG or more (four-wire), 
  2 pair 24 AWG or more (two-wire)
• Characteristic impedance: 100 Ω
• Capacitance: 50 pF/m
•Total cable length: Up to 1.2 km

Connecting to the USB Port (/USB1)
The USB port complies with Rev. 1.1.

		  USB port
USB port

RearFront

USB CF  CARD

Connecting to the Ethernet Port

		

Ethernet port
Indicator

Do not connect an Ethernet cable whose plug does 
not comply with FCC specifications. If you do, the
DX may malfunction.

CAUTION

Checking the Connection/Communication Status
You can check the connection status of the Ethernet interface with the indicators that are 
located above the Ethernet connector of the DX.

Indicator Connection Status of the Ethernet Interface
Illuminated (green) The Ethernet interface is electrically connected.
Blinking (red) Transmitting data.
Off The Ethernet interface is not electrically connected.

Checking the Connection on the DX Display
•	� Checking the Connection at the status indication section of the DX 

display.
	 You can check the connection status of the Ethernet interface on the Ethernet Link 

indicator located on the right side of the status display section of the basic setting 
mode display. The basic setting menu appears by pressing MENU to display the 
setting menu followed by FUNC for approximately 3 s.

•	� Checking the Connection Status in the Display Section in the Upper 
Right Corner of the COMMUNICATION LOG Display of the DX

	 You can check the connection status of the Ethernet interface on the Link indicator on 
the display section in the upper right corner of the COMMUNICATION LOG display.
Indicator Connection Status of the Ethernet Interface
Illuminated (green) The Ethernet interface is electrically connected.
Off The Ethernet interface is not electrically connected.
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Power Supply Wiring
Panel Mount Type, or Desktop Type with /P1 (Models with /H5 and /P1 Options)

Precautions to Be Taken While Wiring the Power Supply
Make sure to follow the warnings below when wiring the power supply. To prevent electric 
shock and damage to the DX, observe the following warnings.

	 WARNING
•	 To prevent electric shock when wiring, ensure the main power supply is turned 

OFF.
•	 To prevent the possibility of fire, use 600 V PVC insulated wire (AWG20-16) or 

an equivalent wire for power wiring.
•	 Make sure to earth ground the protective earth terminal through a grounding 

resistance less than 100 Ω before turning ON the power.
•	 Use crimp-on lug with insulation sleeves (for 4-mm screws) for power supply 

wires and protective grounding wires.
•	 To prevent electric shock, make sure to close the transparent cover for the 

power supply wires.
•	 Make sure to provide a power switch (double-pole type) on the power supply line in 

order to separate the DX from the main power supply. Put an indication on this switch 
as the breaker on the power supply line for the DX and indications of ON and OFF. 
Switch specifications 

	 Steady-state current rating: 1 A or more (other than /P1), 3 A or more (/P1). 
	 Inrush current rating: 60 A or more (other than /P1), 70 A or more (/P1). 
	 Use a switch complies with IEC60947-1, 3.
•	 Connect a fuse (between 2 A and 15 A) to the power line. Use a fuse approved 

by CSA (for the use in North America) or VDE (for the use in Europe).
•	 Do not add a switch or fuse to the ground line.

Use a power supply that meets the following conditions:
Item Other than /P1 /P1
Rated supply voltage 100 to 240 VAC 24 VDC/AC
Allowable power supply voltage range 90 to 132, 180 to 264 VAC 21.6V to 26.4 VDC/AC
Rated power supply frequency 50/60 Hz 50/60 Hz (for AC)
Allowable power supply frequency range 50/60 Hz ± 2% 50/60 Hz ± 2% (for AC)
Maximum power consumption 45 VA (100 V)/60 VA (240 V) 28 VA (for DC), 45 VA (for AC)

Note
Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on 
the measurement accuracy.

Wiring Procedure
1.	 Turn OFF the power to the DX and open the transparent power terminal cover.

2.	 Wire the power cord and the protective ground cord to the power supply terminals. 
Use ring-tongue crimp-on lugs (designed for 4 mm screws). The proper torque for 
tightening the screw is 1.4 to 1.5 N•m (12.4 to 13.2 inch•lbs).

			 

Power cord

Functional ground terminal
Protective grounding cord

NL

AC~
60VA MAX50/60Hz

100-240V

Note
Do not wire the protective grounding 
cord to the functional ground terminal.

24V DC
24V AC 50/60Hz 45VA MAX

28VA MAX

Other than /P1 /P1
(24 VDC/AC power supply)

3.	 Replace the power terminal cover, and fasten it with screws.

Installation and Wiring
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Desktop Type (/H5[ ] Option)
Precautions to Be Taken While Connecting the Power Supply
Make sure to follow the warnings below when connecting the power supply. To prevent 
electric shock and damage to the DX, observe the following warnings.

	 WARNING
•	 Before connecting the power cord, ensure that the source voltage matches the 

rated supply voltage of the DX and that it is within the maximum rated voltage 
range of the provided power cord.

•	 Connect the power cord after checking that the power switch of the DX is turned 
OFF.

•	 To prevent electric shock or fire, be sure to use the power cord supplied by 
YOKOGAWA.

•	 Make sure to perform protective earth grounding to prevent electric shock. 
Connect the power cord of the desktop type to a three-prong power outlet with a 
protective earth terminal.

•	 Do not use an extension cord without protective earth ground. Otherwise, the 
protection function will be compromised.

Use a power supply that meets the following conditions:
Item Condition
Rated supply voltage 100 to 240 VAC
Allowable power supply voltage range 90 to 132, 180 to 264 VAC
Rated power supply frequency 50/60 Hz
Allowable power supply frequency range 50/60 Hz ± 2%
Maximum power consumption 45 VA (100V) and 60 VA (240 V)

Note
Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on 
the measurement accuracy.

Connection Procedure
1.	 Check that the power switch is OFF.

2.	 Connect the power cord plug to the power connector on the rear panel. (Use the 
power cord that comes with the package.)

					   

3.	 Check that the power outlet meets the conditions given in the table above and 
that the supply voltage is within the maximum rated voltage range of the power 
cord that comes with the package. Then, connect the other end of the power cord 
to the power outlet. The AC outlet must be of a three-prong type with a protective 
earth ground.

Installation and Wiring
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Recommended Replacement Periods for Worn Parts

To preserve the reliability of the DX and to use the DX in a good condition for an 
extended time, it is recommended that periodic replacements be made on parts. The 
replacement parts may change to accommodate preventive maintenance over extended 
time. Be sure to check with your nearest YOKOGAWA dealer.
The following table shows the recommended replacement period for expendable parts. 
The replacement period shown here applies when the recorder is used under standard 
operating conditions. For the actual replacement period, consider the actual conditions 
of use. Replacement of parts will be carried out by a YOKOGAWA engineer or an 
engineer certified by YOKOGAWA. Contact your nearest YOKOGAWA dealer when such 
replacement is necessary.

Item Replacement 
period Name Part No. Quantity 

Used Notes

LCD 5 years Back Light Unit B8703KB 1
Battery 10 years Battery Assembly B9900BR 1
Dust and water  
proof strip

5 years Packing B8705FY 1
5 years Key Case Assembly B8705BM 1 Without /KB1 or /KB2
5 years Key Case Assembly B8705BY 1 With /KB1 or /KB2

Aluminum 
electrolytic capacitor

5 years* Power Supply Assembly – 1
5 years* AD Assembly Depends on the model

*	 Replacement period at the upper limit of the normal operating temperature (50°C)
	 The replacement period varies depending on the operating temperature and the specifications of the DX.
	 The lower the operating temperature, the longer is the replacement period. For example, if the operating 
	 temperature is 30°C, it may be possible to use the parts for more than 10 years.

Note
•	 The LCD replacement period indicates the half life of the brightness when the brightness 

is set to the factory default setting. The half life is shortened as the brightness is set 
higher. The deterioration of brightness varies depending on the condition of use, and its 
determination is subjective. Consider these facts for determining the actual replacement 
period.

•	 The color of the LCD may become yellowish as time elapses. The discoloration tends to 
progress faster as the brightness is set higher.
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Setup Items and Default Values

The setup items and the default values in the setting mode are listed below. Enter the 
settings that you are using in the Setting column for your convenience.

Setting mode menu

			 

*: Optional.

End: /AS1 option

Setup Items and Default Values

Page 78
Page 78 to 80
Page 81 to 82*

Page 83
Page 84
Page 84
Page 84 to 85
Page 87
Page 87*

Page 87

Page 87
Page 87

Page 87*

Page 88*

Page 88*

Page 88*

Page 88*

Page 88*

Page 88
Page 89
Page 89
Page 89
Page 89
Page 89
Page 89*

Page 89*

Page 89
Page 89
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Basic setting mode menu

			 

*1: Optional.
*2: Displayed when the function is enabled in the Environment settings.

Communication (PROFIBUS-DP): For models with 
thePROFIBUS-DP interface (/CP1 option).
Signature: For models with the Advanced Security 
(/CP1 option).

Setup Items and Default Values

Page 90
Page 90
Page 90
Page 90
Page 90*1

Page 91
Page 91
Page 91
Page 91*1

Page 92*1

Page 92

Page 93
Page 93
Page 93
Page 94*2

Page 94 to 95*2

Page 96*1

Page 96
Page 97 to 101
Page 101*1

Page 102*1

Page 102
Page 102

Page 101*

Page 93*

Page 103
Page 103
Page 103
Page 103
Page 103
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Setup Items in Setting Mode and Their Default Values

Menu tab
Date/Time > Date&Time
Setup Item Selectable Range or Selections Default Value Setting
Date&Time > Time set – 2011/01/01 00:00:00

Date/Time > Daylight Saving Time
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Start time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/

OCT/NOV/DEC
MAR

Start time > Day order 1st/2nd/3rd/4th/Last 2nd
Start time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Start time > Hour of the day Numerical value 2
End time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/

OCT/NOV/DEC
NOV

End time > Day order 1st/2nd/3rd/4th/Last 1st
End time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
End time > Hour of the day Numerical value 1

Meas channel > Range, Alarm
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH
Range > Mode

Channel number
Skip/Volt/TC/RTD/Scale/Delta/DI/
1-5V/Sqrt

001
Volt

Mode=Volt
Range
Span Lower
Span Upper

20mV/60mV/200mV/2V/6V/20V/50V
Depends on the range.
Depends on the range.

2V
–
–

Mode=TC
Range
Span Lower
Span Upper

R/S/B/K/E/J/T/N/W/L/U/WRe
(Options may add additional settings.)
Depends on the range.
Depends on the range.

R
–
–

Mode=RTD
Range
Span Lower
Span Upper

Pt/JPt (Options may add additional settings.)
Depends on the range.
Depends on the range.

Pt
–
–

Mode=Scale
Type
Range
Span Lower
Span Upper
Scale Lower
Scale Upper
Unit

Volt/TC/RTD/DI
Depends on the type.
Depends on the range.
Depends on the range.
–30000 to 30000, decimal position: 0 to 4
–30000 to 30000, decimal position: 0 to 4
6 characters or less

Volt
–
–
–
0.00
200.00
–

Mode=Delta
Type
Range
Span Lower
Span Upper
Ref.CH

Volt/TC/RTD/DI
Depends on the type.
Depends on the range.
Depends on the range.
Meas channel number

Volt
–
–
–
–

Setup Items and Default Values
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Setup Item Selectable Range or Selections Default Value Setting
Mode=DI

Range
Span Lower
Span Upper

Level/Cont
0, 1
0, 1

Level
0
1

Mode=1-5V
Range
Span Lower
Span Upper
Scale Lower
Scale Upper
Unit
Low-cut

1-5V
0.800 to 5.200
0.800 to 5.200
–30000 to 30000, decimal position :0 to 4
–30000 to 30000, decimal position :0 to 4
6 characters or less
On/Off

1-5V
1.000
5.000
0.00
200.00
–
Off

Mode=Sqrt
Range
Span Lower
Span Upper
Scale Lower
Scale Upper
Unit
Low-cut
Low-cut value

20mV/60mV/200mV/2V/6V/20V/50V
Depends on the range.
Depends on the range.
–30000 to 30000, decimal position: 0 to 4
–30000 to 30000, decimal position: 0 to 4
6 characters or less
On/Off
0.0 to 5.0

–
–
0.00
200.00
–
Off
0.5

Alarm
1, 2, 3, 4
Type 

Value
Relay
Number

Detect

On/Off
H:High/L:Low/h:delta H/l:delta L/R:rate H/ 
r:rate L/T:delayH/t:delayL
Numerical value
On/Off
I01/.../I06 (Depends on the option.)
S01/S02/S03/.../S29/S30
On/Off

Off
H 

–
Off
I01

On

Meas channel > Tag, Memory, Delay
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
First-CH, Last-CH Channel number 001
Tag > Comment 32 characters or less –
Tag > No. 16 characters or less –
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10
With /AS1
The First-CH, Last-CH, Tag, and Memory sample items are the same as on a DX without the /AS1 option.
Alarm delay > Time 1 to 3600 when the unit is seconds. 1 to 24 when 

the unit is hours.
10

Alarm delay > Unit Hour/Sec Sec

Meas channel > Moving average
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Moving average > On/Off On/Off Off
Moving average > Count 2 to 400 2

Setup Items and Default Values



80 IM 04L45B01-02EN

Meas channel > Color
Setup Item Selectable Range or Selections Default Value Setting
Group of channel 001-006, etc Depends on the model.
Color Red/Green/Blue/B.violet/Brown/Orange/ 

Y.green/Lightblue/Violet/Graly/Lime/Cyan/ 
Darkblue/Yellow/Lightgray/Purple/Black/Pink/ 
L.brown/L.green/Darkgray/Olive/DarkCyan/ 
S.green (24 colors)

Red to Gray 

Meas channel > Zone, Scale
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Zone > Lower
Zone > Upper

0 to 95
5 to 100

0
100

Scale > Position
Scale > Division

Off/1/2/3/4/5/6
4/5/6/7/8/9/10/11/12/C10

1
10

Meas channel > Bar graph
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Bar graph > Base position
Bar graph > Division

Normal/Center/Lower/Upper
4/5/6/7/8/9/10/11/12

Normal
10

Meas channel > Partial
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
On/Off On/Off Off
Expand 1 to 99% 50
Boundary Span Lower+1digit to Span Upper-1digit 0.0000

Meas channel > Alarm mark
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Mark kind
Indicate on Scale
Alarm mark color > Alarm 1 
Alarm mark color > Alarm 2 
Alarm mark color > Alarm 3 
Alarm mark color > Alarm 4 

Alarm/Fixed
On/Off
Auto/Red/Green/.../S.green (24 colors)
Same as Alarm 1
Same as Alarm 1
Same as Alarm 1

Alarm
Off
Red
Orange
Orange
Red

Meas channel > Color scale band
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Band area
Color
Display position > Lower
Display position > Upper

Off/In/Out
Red/Green/.../S.green (24 colors)
Measuring range
Measuring range

Off
Lime
0.0000
0.0100

Meas channel > Calibration correction
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Number of set points Off/2/3/4/5/6/7/8/9/10/11/12/13/14/15/16 Off
1 to n > MES val
1 to n > True val

Value in the measuring range/measured value
Measuring range

–
–

Setup Items and Default Values
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Math channel > Expression, Alarm
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
Math On/Off
Calculation expression
Span Lower
Span Upper
Unit

On/Off
120 characters or less
–9999999 to 99999999, decimal position: 0 to 4
–9999999 to 99999999, decimal position: 0 to 4
6 characters or less

Off
–
–200.00
200.00
–

Math alarm
1, 2, 3, 4
Type
Value
Relay
No.

Detect

On/Off
H:High/L:Low/T:delayH/t:delayL
Numerical value
On/Off
I01/.../I06 (Depends on the option.)
S01/S02/S03/.../S29/S30
On/Off

Off
H
–
Off
I01

On

Math channel > Constant
Setup Item Selectable Range or Selections Default Value Setting
Number of constant K01 to K60 K01
Value –9.9999E+29 to –1.0000E–30, 0, 

1.0000E–30 to –9.9999E+29
1

Math channel > Tag, Memory, Delay
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
Tag > Comment 32 characters or less –
Tag > No. 16 characters or less –
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10

Math channel > TLOG, Rolling average
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
TLOG > Timer type
TLOG > Timer No. 
 

TLOG > Sum scale
TLOG > Reset

Timer/Match T
1/2/3/4 
1/2/3/.../11/12 (on models with the /BT2 multi 
batch option)
Off, /s, /min, /h
On/Off

Timer
1 
 

Off
Off

Rolling average > On/Off
Rolling average > Interval 
 

Rolling average > Number of samples

On/Off
1s/2s/3s/4s/5s/6s/10s/12s/15s/20s/30s/ 
1min/2min/3min/4min/5min/6min/10min/12min/ 
15min/20min/30min/1h
1 to 1500

Off
10s 
 

1

Math channel > Color
Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Zone, Scale
Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Bar graph
Setup items and values are the same as those for measurement channels, except the channel numbers.

Setup Items and Default Values
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Math channel > Partial
Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Alarm mark
Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Color scale band
Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Math start action
Setup Item Selectable Range or Selections Default Value Setting
Math start action > Math start Off/Start/Rst+St Start

Setup Items and Default Values
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Display > Trend/Save interval
Setup Item Selectable Range or Selections Default Value Setting
Trend interval [/div] 
 

Save interval 
Second interval [/div]

5s/10s/15s/30s/1min/2min/5min/10min/15min
/20min/30min/1h/2h/4h/10h (Depends on the 
model.)
10min to 31day (Depends on the trend interval.) 
5s/10s/15s/30s/1min/2min/5min/10min/15min
/20min/30min/1h/2h/4h/10h (Depends on the 
model.)

1min 
 

1h 

1min

Display > Trend
Setup Item Selectable Range or Selections Default Value Setting
Direction
Trend clear
Message direction
Scale > Digit
Scale > Value indicator
Trend line
Grid

Horizontal/Vertical/Wide/Split
On/Off
Horizontal/Vertical
Normal/Fine
Mark/Bargraph
1/2/3
Auto/4/5/6/7/8/9/10/11/12

Vertical
Off
Horizontal
Normal
Mark
2
Auto

Display > Bar graph
Setup Item Selectable Range or Selections Default Value Setting
Direction Horizontal/Vertical Vertical

Display > LCD
Setup Item Selectable Range or Selections Default Value Setting
Brightness
Backlight saver > Mode
Backlight saver > Saver time
Backlight saver > Restore

1/2/3/4/5/6/7/8
Off/Dimmer/Timeoff
1min/2min/5min/10min/30min/1h
Key, Key+Alarm

2
Off
1h
Key+Alarm

Display > Monitor
Setup Item Selectable Range or Selections Default Value Setting
Background > Display
Background > Historical trend
Scroll time
Jump default display

White/Black
White/Cream/Black/Lightgray
5s/10s/20s/30s/1min 
Off/1min/2min/5min/10min/20min/30min/1h

White
Black
10s
Off

Display > Annunciator
Setup Item Selectable Range or Selections Default Value Setting
Annunciator position 1 to 24 1
On/Off On/Off Off
Channel Channel number 001
Level 1 /2/3/4/All 1
Comment txt block No. 1 to 50 1

Display > FAVORITE Key action
Setup Item Selectable Range or Selections Default Value Setting
Action History/Favorite Favorite
Group display Current/Saved Saved
Time axis zoom Current/Saved Saved

Setup Items and Default Values
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Group set, Trip line
Setup Item Selectable Range or Selections Default Value Setting
Group number 1/2/3/.../9/10 1
Group set > On/Off

Group set > Group name
Group set > CH set

On/Off

16 characters or less
39 characters or less

Group 1 to 4: On
Group 5 to 10: Off
GROUP1 etc.
Depends on the model.

Trip line
1, 2, 3, 4
Position
Color 

Width

On/Off
0 to 100
Red/Green/.../S.green (24 colors) 

1/2/3

Off
50
1:Red, 2:Green 
3:Blue, 4:Yellow
2

Message, Comment Text > Message
Setup Item Selectable Range or Selections Default Value Setting
Message No. 1-10/11-20/21-30/31-40/41-50/51-60/ 

61-70/71-80/81-90/91-100
11-20

1 to 100 32 characters or less –

Message, Comment Text > Comment text fields
Setup Item Selectable Range or Selections Default Value Setting
Coment txt field no 1 to 100 1
Text info 32 characters or less –

Message, Comment Text > Comment text block
Setup Item Selectable Range or Selections Default Value Setting
Coment txt block no 1 to 50 1
Line > 1 > Comment txt field no 1 to 100 1
Line > 2 > Comment txt field no 1 to 100 1
Line > 3 > Comment txt field no 1 to 100 1
Line > 4 > Comment txt field no 1 to 100 1
Line > 5 > Comment txt field no 1 to 100 1

Timer, Event action > Timer
Setup Item Selectable Range or Selections Default Value Setting
Timer No. 1/2/3/4

1/2/3/.../11/12 (on models with the /BT2 multi 
batch option)

1

Mode Off/Relative/Absolute Off
Relative > Interval
Relative > Reset at Math Start

00:01 to 24:00
On/Off

01:00
On

Absolute > Interval 
 

Absolute > Ref.time

1min/2min/3min/4min/5min/6min/10min/ 
12min/15min/20min/30min/1h/2h/3h/4h/ 
6h/8h/12h/24h
0 to 23

1h 
 

0:00

Timer, Event action > Match time timer
Setup Item Selectable Range or Selections Default Value Setting
Timer number 1/2/3/4 

1/2/3/.../11/12 (on models with the /BT2 multi 
batch option)

1

Kind Off/Day/Week/Month/Year Off
Day 1 to 31 (varies depending on the month) 1
Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Hour 00:00 to 23:59 00:00
Timer action Single/Repeat Repeat

Setup Items and Default Values
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Timer, Event action > Event action
Setup Item Selectable Range or Selections Default Value Setting
Logic box number 1/2/3/.../39/40 1
Event 
 

Remote > Remote number
Relay > Relay number
Switch > Switch No.
Timer > Timer No. 
 

MatchTimeTimer > Match Time Timer 
No. 

EventLevelSwitch > Event Switch No
EventEdgeSwitch > Event Switch No
Relay-Off > Relay number
Switch-Off > Switch No.*

EventLevelSwitch-Off > Event Switch 
No

None/Remote/Relay/Switch/Timer/ 
Matchtime/Alarm/UserKey/EventLevelSwitch/
EventEdgeSwitch/
Relay-Off/Switch-Off/Alarm-Off/ 
EventLevelSwitch-Off
1/2/3/4/5/6/7/8
I01/.../I06 (Depends on the option.)
S01/S02/S03/.../S29/S30
1/2/3/4 
1/2/3/.../11/12 (on models with the /BT2 multi  
batch option)
1/2/3/4 
1/2/3/.../11/12 (on models with the /BT2 multi  
batch option)
1/2/3/.../29/30
1/2/3/.../29/30
I01/.../I06 (Depends on the option.)
S01/S02/S03/.../S29/S30
1/2/3/.../30

None 
 

1
I01
S01
1 
 

1 
 

1
1
I01
S01
1
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Setup Item Selectable Range or Selections Default Value Setting
Action 
 
 
 
 
 

Message > Message No.
Message > Write to
Message > Group number
Group > Group numbe
FavoriteDisplay > Action
FavoriteDisplay > Select 
> Favorite Screen No
CommentDisplay  
> Comment Txt Block No
Flag > Flag number
TimerReset > Timer No. 
 

PanelLoad > Setting file number

MemoryStart/Stop, MemoryStart, MemoryStop, 
Trigger (not selectable on a DX with the /
AS1 option) , AlarmACK, AlarmDisplayReset, 
MathStart/Stop, MathStart, MathStop, MathReset, 
SaveDisplay, SaveEvent, Message, Snapshot, 
DisplayRate1/2, ManualSample, TimerReset, 
DisplayGroupChange, FavoriteDisplay, 
CommentDisplay, Flag, PanelLoad (not selectable 
on a DX with the /AS1 option) , TimeAdjust 
(Depends on the events, etc)
1 to 100
All/Select
1/2/3/.../9/10
1/2/3/.../9/10
Key/Select
 
1/2/3/4/5/6/7/8
 
1 to 50
1/2/3/4/5/6/7/8
1/2/3/4 
1/2/3/.../11/12 (on models with the /BT2 multi  
batch option)
1/2/3

Group 
 
 
 
 
 

1
All
1
1
Key
 
1
 
1
1
1 
 

1

The following menus appear when the multi batch function is in use.
MemoryStart/Stop > Target Action
MemoryStart/Stop > Select  
> Batch Group No
MemoryStart > Target Action
MemoryStart > Select   
> Batch Group No
MemoryStop > Target Action
MemoryStop > Select   
> Batch Group No
SaveDisplay > Target Action
SaveDisplay > Select  
> Batch Group No
SaveEvent > Target Action
SaveEvent > Select  
> Batch Group No
MathReset > Target Action
MathReset > Select  
> Batch Group No
Message > Message No.
Message > Write to
Message > Select  
> Batch Group No
> Display Group No
Message > All 
> Batch Group No
DisplayGroupChange  
> Batch Group No
DisplayGroupChange  
> Display Group No

All/Select
 
1/2/3/4/5/6 (varies depending on settings)
All/Select
 
1/2/3/4/5/6 (varies depending on settings)
All/Select
 
1/2/3/4/5/6 (varies depending on settings)
All/Select
 
1/2/3/4/5/6 (varies depending on settings)
All/Select
 
1/2/3/4/5/6 (varies depending on settings)
All/Select
 
1/2/3/4/5/6 (varies depending on settings)
1 to 100
All/Select
 
1/2/3/4/5/6 (varies depending on settings)
1/2/3/4/5/6
 
1/2/3/4/5/6 (varies depending on settings)
 
1/2/3/4/5/6 (varies depending on settings)
 
1/2/3/4/5/6

All
 
1
All
 
1
All
 
1
All
 
1
All
 
1
All
 
1
1
All
 
1
1
 
1
 
1
 
1

Setup Items and Default Values
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Data save > File header, File name
Setup Item Selectable Range or Selections Default Value Setting
File header > Characters 50 characters or less –
Data file name > Structure Date/Serial/Batch Date
Data file name > Identified strings 16 characters or less –

Data save > Save directory
Setup Item Selectable Range or Selections Default Value Setting
Directory name 20 characters or less DATA0

Data save > Event data
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Sample rate 25ms/125ms/250ms/500ms/1s/2s/5s/10s/30s/60s

/120s/300s/600s/15min/20min/30min
 (Depends on the model.) 

1s

Mode Free/Single/Repeat Free
Data length 10min to 31day (Depends on the sample rate.) 1h
Pre-trigger 0/5/25/50/75/95/100 0
Trigger signal > Key On/Off On
With /AS1
The Sample rate and Data length items are the same as on a DX without the /AS1 option.
Mode Fixed at Free Free
There are no Pre-trigger or Trigger signal > Key items.

Data save > Batch text
Setup Item Selectable Range or Selections Default Value Setting
Text field number 1 to 24 1
Text field > Title of field
Text field > Characters

20 characters or less
30 characters or less

–
–

Web Report
Setup Item Selectable Range or Selections Default Value Setting
Web Report No 1/2/3/4/5/6/7/8/9/10 1
On/Off On/Off Off
Title 64 characters or less –
Item No 1-5/6-10 1-5
Item > 1 to 10 On/Off Off
Item > 1 to 10 > Channel R01/R02/.../R24 R01
Item > 1 to 10 > Value Max/Min/Ave/Sum/Inst Sum
Item > 1 to 10 > Name 16 characters or less –

Menu customize
Setup Item Selectable Range or Selections Default Value Setting
Function menu Select/Hide/View/Transfer –
Display menu Separate/Select/Hide/View/Transfer –

End (/AS1 option)
Setup Item Selectable Range or Selections Default Value Setting
End Yes/No –

Basic setting mode
Setup Item Selectable Range or Selections Default Value Setting
Entering basic setting mode. ... Yes/No –

Setup Items and Default Values



88 IM 04L45B01-02EN

Multi batch tab
Group set, Trip line > Group set
Setup Item Selectable Range or Selections Default Value Setting
First Batch Group, Last Batch Group 1/2/3/4/5/6 (varies depending on settings) 1
Display Group No 1/2/3/4/5/6 1
Set Display Group > On/Off
Set Display Group > Group name
Set Display Group > CH set

On/Off
16 characters or less
23 characters or less

Off
BATCH-1, etc.
Depends on the model.

Group set, Trip line > Trip line
Setup Item Selectable Range or Selections Default Value Setting
First Batch Group, Last Batch Group 1/2/3/4/5/6 (varies depending on settings) 1
Display Group No 1/2/3/4/5/6 1
Trip line

1, 2, 3, 4
Position
Color 

Width

On/Off
0 to 100
Red/Green/.../S.green (24 colors) 

1/2/3

Off
50
1:Red, 2:Green 
3:Blue, 4:Yellow
2

File header, File name
Setup Item Selectable Range or Selections Default Value Setting
First Batch Group, Last Batch Group 1/2/3/4/5/6 (varies depending on settings) 1
File header > Characters 50 characters or less –
Data file name > Structure Date/Serial/Batch Date
Data file name > Identified strings 16 characters or less –

Data save > Batch text
Setup Item Selectable Range or Selections Default Value Setting
First Batch Group, Last Batch Group 1/2/3/4/5/6 (varies depending on settings) 1
Text field number 1 to 24 1
Text field > Title of field 20 characters or less –
Text field > Characters 30 characters or less –

End (/AS1 option)
Setup Item Selectable Range or Selections Default Value Setting
End Yes/No –

Set Calibration Tab
Setup Item Selectable Range or Selections Default Value Setting
Calibration correction Same as Meas channel > Calibration correction
Finish Calibration > Next calibration due Year, month, and date –
Finish Calibration > Execute – –

End (/AS1 option)
Setup Item Selectable Range or Selections Default Value Setting
End Yes/No –

File tab
Load display data
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF

Setup Items and Default Values
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Load event data
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF

Load settings
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF

Save settings
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
File name 32 characters or less –

Custom display load > Select
Setup Item Selectable Range or Selections Default Value Setting
Display No. Internal 1 to Internal 3, External 1 to External 25 Internal 1
File selection screen – –

Custom display load > All
Setup Item Selectable Range or Selections Default Value Setting
Directory selection screen – –

Custom display save > Select
Setup Item Selectable Range or Selections Default Value Setting
Display No. Internal 1 to Internal 3, External 1 to External 25 Internal 1
File name 32 characters or less –

Custom display save > All
Setup Item Selectable Range or Selections Default Value Setting
Directory name 20 characters or less –

File list/delete (Delete is not available on DXs with the /AS1 option.)
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF

Load template
Setup Item Selectable Range or Selections Default Value Setting
Report Kind Hour, Day, Week, Month, Hour+Day, Day+Week, 

Day+Month
–

Save template
Setup Item Selectable Range or Selections Default Value Setting
Report Kind Hour, Day, Week, Month, Hour+Day, Day+Week, 

Day+Month
–

Template data save > File name 32 characters or less –

Format (Without /AS1)
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
Format > Volume name 11 characters or less –

End (/AS1 option)
Setup Item Selectable Range or Selections Default Value Setting
End Yes/No –

Setup Items and Default Values
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Setup Items in Basic Setting Mode and Their Default Values

Environment tab
Operating environment
Setup Item Selectable Range or Selections Default Value Setting
Tag/Channel Tag/Channel Tag
Language English/Japanese/German/French/Chinese English
Temperature C/F C
Decimal Point Type Point/Comma Point
Basic setting mode Menu display On/Off On

View, Message
Setup Item Selectable Range or Selections Default Value Setting
View > Trend type
View > Partial
View > Trend rate switching

T-Y
On/Off
On/Off

T-Y
Off
Off

Message > Write group
Message > Power-fail message
Message > Change message

Common/Separate
On/Off
On/Off

Common
Off
Off

Input, Tag
Setup Item Selectable Range or Selections Default Value Setting
Input > Value on over-range Free/Over Over
Tag Basic settings > Tag No. Use/Not Use/Not Not

Alarm > Action
Setup Item Selectable Range or Selections Default Value Setting
No logging On/Off Off
Annunciator mode
Sequence
Time off color

On/Off
ISA-A-4/ISA-A/ISA-M
White/Green

Off
ISA-A
Green

Alarm > Level/Color
Setup Item Selectable Range or Selections Default Value Setting
Level 1-2-3-4/1-4-2-3/1-4-3-2 1-2-3-4
Color > 1
Color > 2
Color > 3
Color > 4

Red/Yellow/Orange/Pink
Red/Yellow/Orange/Pink
Red/Yellow/Orange/Pink
Red/Yellow/Orange/Pink

Red
Red
Red
Red

Remote
Setup Item Selectable Range or Selections Default Value Setting
Level 1-2-3-4/1-4-2-3/1-4-3-2 1-2-3-4
Remote Input > 1
Remote Input > 2
Remote Input > 3
Remote Input > 4
Remote Input > 5
Remote Input > 6
Remote Input > 7
Remote Input > 8

N.O/N.C
N.O/N.C
N.O/N.C
N.O/N.C
N.O/N.C
N.O/N.C
N.O/N.C
N.O/N.C

N.O
N.O
N.O
N.O
N.O
N.O
N.O
N.O

Setup Items and Default Values
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Security, Media save
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Security > Key
Security > Communication
Security > Touch panel

Off/Login/Keylock
Off/Login
Off/On/Password

Off
Off
On

Save > Auto save
Save > Media FIFO

On/Off
On/Off

On
Off

With /AS1
Security > Key Login Login
Security > Communication Off/Login Off
Security > Multi login On/Off Off
Security > Password management On/Off Off
Security > Touch panel Off/On/Password On
The Save items are the same as on a DX without the /AS1 option.

Batch
Setup Item Selectable Range or Selections Default Value Setting
On/Off
Lot-No. digit
Auto increment
Batch operation qty

On/Off/MultiBatch
Off/4/6/8
On/Off
2/3/4/5/6

Off (With /AS1, On)
6
On
4

Communication > Service port
Setup Item Selectable Range or Selections Default Value Setting
FTP 1 to 65535 21
HTTP 1 to 65535 80
SNTP 1 to 65535 123
Modbus 1 to 65535 502

Communication > POP3 Details
Setup Item Selectable Range or Selections Default Value Setting
POP Before SMTP > Send delay [second] 0/1/2/3/4/5/6/7/8/9/10 2
POP3 Login PLANE/APOP PLAIN

Communication > FTP Server Details
Setup Item Selectable Range or Selections Default Value Setting
Output Directory Format MS-DOS/UNIX MS-DOS

Math
Setup Item Selectable Range or Selections Default Value Setting
Value on Error
Value on Overflow > SUM, AVE
Value on Overflow > MAX, MIN, P-P

+Over/–Over
Error/Skip/Limit
Over/Skip

+Over
Skip
Over

Setup Items and Default Values
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Report
Setup Item Selectable Range or Selections Default Value Setting
Report select > 1
Report select > 2
Report select > 3
Report select > 4
File type
Use Template

Max/Min/Ave/Sum/Inst
Off/Max/Min/Ave/Sum/Inst
Off/Max/Min/Ave/Sum/Inst
Off/Max/Min/Ave/Sum/Inst
Separate/Combine/Separate2
Use/Not

Ave
Max
Min
Sum
Separate
Not

End
Setup Item Selectable Range or Selections Default Value Setting
Do you want to store and 
make the new settings take effect?

Yes/No/Cancel –

Setup Items and Default Values
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Menu tab
Alarm > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Reflash
Rate of change > Decrease
Rate of change > Increase
Indicator

On/Off/On-1s/On-2s
1 to 32
1 to 32
Hold/Nonhold

Off
1
1
Nonhold

Alarm > Switch, Relay
Setup Item Selectable Range or Selections Default Value Setting
Internal Switch > AND
Relay > AND
Relay > Action
Relay > Hold
Relay > Relay Action on ACK

None/S01/S01-S02/.../S01-S29/S01-S30
None/I01/I01-I02/.../I01-I06 (Depends on the option.)
Energize/De_energ
Hold/Nonehold
Normal/Reset

None
None
Energize
Nonhold
Normal

Alarm > Hysteresis
Setup Item Selectable Range or Selections Default Value Setting
Meas CH > High/Low
Meas CH > Delta High/Low
Math CH > High/Low

0.0 to 5.0
0.0 to 5.0
0.0 to 5.0

0.5
0.0
0.0

A/D, Memory
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Scan interval > Scan mode

Normal > Scan interval 

Normal > A/D integrate
Fast†> Scan interval

Fast†> A/D integrate

Normal/Fast
125ms/250ms (DX1002T, DX1004T) 
1s/2s/5s (DX1006T, DX1012T)
Auto/50Hz/60Hz/100ms
25ms (DX1002T, DX1004T) 
125ms (DX1006T, DX1012T)
600Hz

Normal
125ms 
1s
Auto
25ms 
125ms
600Hz

Memory > Data kind Display/E+D/Event Display
With /AS1
The Scan interval items are the same as on a DX without the /AS1 option.
Memory > Data kind Display/Event Display
†: You cannot select this option on a DX with external input channels (/MC1) or when the multi batch function (/BT2) is in use.

Signature (/AS1 option)
Setup Item Selectable Range or Selections Default 

Value
Setting

Process type Batch/Continue Batch
Sign from recorder Off/Sign1/Sign1+2/Sign1+2+3 Off
Signature at batch stop On/Off Off
FTP transfer at signing On/Off Off

Burnout, RJC
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Burnout set > Mode Off/Up/Down Off
RJC > Mode
RJC > Volt

Internal/External
–20000 to 20000µV

Internal
0

Setup Items and Default Values
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Keylock > Password, Key action, Media (Without /AS1)
Setup Item Selectable Range or Selections Default Value Setting
Password 8 characters or less –
Key action > START
Key action > STOP
Key action > MENU
Key action > USER
Key action > DISP/ENTER
Key action > FAVORITE

Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock

Free
Free
Free
Free
Free
Free

Media/USB > External media
Media/USB > Load settings

Free/Lock
Free/Lock

Free
Free

Keylock > Action of Function (Without /AS1)
Setup Item Selectable Range or Selections Default Value Setting
Action of Function > AlarmACK
Action of Function > Message/Batch
Action of Function > Math
Action of Function > Data save
Action of Function > E-mail/FTP
Action of Function > Time set
Action of Function > Display Function

Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock

Free
Free
Free
Free
Free
Free
Free

Login > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Auto logout Off/1min/2min/5min/10min Off
Operation without Login Off/Display Off
With /AS1
Auto logout Off/1min/2min/5min/10min Off
Operation without Login Off/Display Off
User ID Use/Not Use
Password retry frequency 3/5/Off 3
Root password > Password 20 characters or less ????????

Login > Admin settings
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Admin number 1 to 5 1
Mode
User name
Password

Off/Key/Comm/Web/Key+Comm
20 characters or less
20 characters or less

Off
Admin1 etc.
????????

With /AS1
Admin number 1 to 5 1
Mode Off/Key/Web/Key+Comm Off
User name 20 characters or less Admin1 etc.
User ID 8 characters or less –
Password 20 characters or less ????????
Password expire Off/1month/3month/6month Off

Setup Items and Default Values
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Login > User settings
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
User number 1 to 30 1
Mode
User name
Password
Authority of user

Off/Key/Comm/Web/Key+Comm
20 characters or less
20 characters or less
Off/1/2/3/4/5/6/7/8/9/10

Off
User1 etc.
????????
Off

With /AS1
User number 1 to 90 1
Mode Off/Key/Comm/Web/Key+Comm Off
User name 20 characters or less User1 etc.
User ID 8 characters or less –
Password 20 characters or less ????????
Password expire Off/1month/3month/6month Off
Authority of user Off/1/2/3/4/5/6/7/8/9/10 Off

Login > Authority of user > Key action, Media
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Authority of user 1/2/3/4/5/6/7/8/9/10 1
Key action > START
Key action > STOP
Key action > MENU
Key action > USER
Key action > DISP/ENTER
Key action > FAVORITE

Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock

Free
Free
Free
Free
Free
Free

Media/USB > External media
Media/USB > Load settings

Free/Lock
Free/Lock

Free
Free

Authority of user
Action of Function > AlarmACK
Action of Function > Message/Batch
Action of Function > Math
Action of Function > Data save
Action of Function > E-mail/FTP
Action of Function > Time set
Action of Function > Display Function

1/2/3/4/5/6/7/8/9/10
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock
Free/Lock

1
Free
Free
Free
Free
Free
Free
Free

With /AS1
The Authority of user, Key action, and Media/USB items are the same as on a DX without the /AS1 option.
Actions > AlarmACK Free/Lock Free
Actions > Message/Batch Free/Lock Free
Actions > Math Free/Lock Free
Actions > Data save Free/Lock Free
Actions > E-mail/FTP Free/Lock Free
Actions > Time set Free/Lock Free
Actions > Display Function Free/Lock Free
Action > Calibration Free/Lock Free
Sign record > Signature1 Free/Lock Free
Sign record > Signature2 Free/Lock Free
Sign record > Signature3 Free/Lock Free

Setup Items and Default Values
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Report > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Report kind Off/Hour/Day/Hour+Day/Day+Week/Day+Month Off
Date 1 to 28 1
Day of the week (Day+week) SUN/MON/TUE/WED/THU/FRI/SAT SUN
Time (hour) 0 to 23 0:00

Report > Report settings
Setup Item Selectable Range or Selections Default Value Setting
Report channel number R01/R02/R03/.../R23/R24 R01
On/Off On/Off Depends on

the model
Channel Channel number 001 etc.
Sum scale Off, /s, /min, /h, /day /s

Time settings
Setup Item Selectable Range or Selections Default Value Setting
Time zone (HHMM)
Time deviation limit
Date format

–1300 to 1300
Off/10s/20s/30s/1min/2min/3min/4min/5min
Y/M/D, M/D/Y, D/M/Y, D.M.Y

900
30s
Y/M/D

Calender display > 1st weekday SUN/MON MON

Setup Items and Default Values
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Communication (Ethernet) > IP-address
Setup Item Selectable Range or Selections Default Value Setting
DHCP Use/Not Not
DNS accession Use/Not Use
Host-name register Use/Not Use
Fixed IP-address > IP-address
Fixed IP-address > Subnet mask
Fixed IP-address > Default gateway

0.0.0.0 to 255.255.255.255
0.0.0.0 to 255.255.255.255
0.0.0.0 to 255.255.255.255

0.0.0.0
0.0.0.0
0.0.0.0

Communication (Ethernet) > Host settings
Setup Item Selectable Range or Selections Default Value Setting
Host name 64 characters or less –
Domain name 64 characters or less –

Communication (Ethernet) > DNS settings
Setup Item Selectable Range or Selections Default Value Setting
Server search order > Primary
Server search order > Secondary

0.0.0.0 to 255.255.255.255
0.0.0.0 to 255.255.255.255

0.0.0.0
0.0.0.0

Domain suffix search order > Primary
Domain suffix search order > Secondary

64 characters or less
64 characters or less

–
–

Communication (Ethernet) > Keep alive, Timeout
Setup Item Selectable Range or Selections Default Value Setting
Keep alive On/Off On
Application time out > On/Off
Application time out > Time

On/Off
1 to 120 (min)

Off
1

Communication(Ethernet) > Server > Server modes
Setup Item Selectable Range or Selections Default Value Setting
FTP Use/Not Use
Web Use/Not Use
SNTP Use/Not Not
Modbus Use/Not Not
EtherNet/IP Use/Not Not

Communication(Ethernet) > Server > Allowed Modbus clients
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Client number 1/2/3/4/5/6/7/8/9/10 1
On/Off On/Off Off

Setup Items and Default Values



98 IM 04L45B01-02EN

Communication (Ethernet) > Web page
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Page type Operator/Monitor Operator
Page type=Operator

Web page > On/Off
Web page > Access control
Web page > Command

On/Off
Off/Admin
Use/Not

Off
Off
Not

Page type=Monitor
Web page > On/Off
Web page > Access control

On/Off
Off/Admin/User

Off
Off

With /AS1
Page type Operator/Monitor Operator
Page type=Operator

Web page > On/Off On/Off Off
Web page > Access control Off/Admin Off

The items when Page type is set to Monitor are the same as on a DX without the /AS1 option.

Communication (Ethernet) > E-Mail > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
SMTP server name
Port number
Security

64 characters or less
0 to 65535
Off/PbS/Auth

–
25
Off

SMTP authorization > User name  
(when Auth is selected)

32 characters or less –

SMTP authorization > Password  
(when Auth is selected)

32 characters or less –

Communication (Ethernet) > E-Mail > Recipients
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 150 characters or less –
Recipient 2 150 characters or less –
Sender 64 characters or less –

Communication (Ethernet) > E-Mail > POP3 settings
Setup Item Selectable Range or Selections Default Value Setting
POP3 Server name 64 characters or less –
Port number 0 to 65535 110
Login name 32 characters or less –
Password 32 characters or less ******...***

Communication (Ethernet) > E-Mail > Alarm settings
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1
Recipient 2

On/Off
On/Off

Off
Off

Active Alarms > Alarm 1
Active Alarms > Alarm 2
Active Alarms > Alarm 3
Active Alarms > Alarm 4

On/Off
On/Off
On/Off
On/Off

Off
Off
Off
Off

Include INST
Include source URL
Subject
Header 1
Header 2

On/Off
On/Off
32 characters or less
64 characters or less
64 characters or less

Off
Off
Alarm_summary
–
–

Send alarm action On+Off/On On+Off
Include tag/ch in Subject On/Off Off

Setup Items and Default Values
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Communication (Ethernet) > E-Mail > Scheduled settings
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1
Interval
Ref.time 
Recipient 2
Interval
Ref.time

On/Off
1h/2h/3h/4h/6h/8h/12h/24h
00:00 to 23:59
On/Off
1h/2h/3h/4h/6h/8h/12h/24h
00:00 to 23:59

Off
24h
00:00
Off
24h
00:00

Include INST
Include source URL
Subject
Header 1
Header 2

On/Off
On/Off
32 characters or less
64 characters or less
64 characters or less

Off
Off
Periodic_data
–
–

Communication (Ethernet) > E-Mail > System settings
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1
Recipient 2

On/Off
On/Off

Off
Off

Include source URL
Subject
Header 1
Header 2

On/Off
32 characters or less
64 characters or less
64 characters or less

Off
System_warning
–
–

Communication (Ethernet) > E-Mail > Report settings
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1
Recipient 2

On/Off
On/Off

Off
Off

Include source URL
Subject
Header 1
Header 2

On/Off
32 characters or less
64 characters or less
64 characters or less

Off
Report_data
–
–

Communication (Ethernet) > FTP client > FTP transfer file
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
FTP transfer file > Disp&Event data
FTP transfer file > Report
FTP transfer file > Snapshot

On/Off
On/Off
On/Off

Off
Off
Off

Transfer wait time > Disp&Event data
Transfer wait time > Report

0 to 120 min
0 to 120 min

0
0

With /AS1
FTP transfer file > Disp&Event data On/Off Off
FTP transfer file > Report On/Off Off
FTP transfer file > Snapshot On/Off Off
FTP transfer file > Setting On/Off Off
The Transfer wait time items are the same as on a DX without the /AS1 option.

Setup Items and Default Values
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Communication (Ethernet) > FTP client > FTP connection
Setup Item Selectable Range or Selections Default Value Setting
FTP connection Primary/Secondary Primary
FTP server name 64 characters or less –
Port number 0 to 65535 21
Login name 32 characters or less –
Password 32 characters or less ******...***
Account 32 characters or less –
PASV mode On/Off Off
Initial path 64 characters or less –

Communication (Ethernet) > SNTP client
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Server name 64 characters or less –
Port number 0 to 65535 123
Access interval Off/1h/8h/12h/24h 8h
Access reference time 00:00 to 23:59 00:00
Access timeout 10s/30s/90s 30s
Time adjust on Start action On/Off Off

Communication (Ethernet) > Modbus client > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s
Retry interva Off/10s/20s/30s/1min/2min/5min/10min/

20min/30min/1h
2min

Communication (Ethernet) > Modbus client > Modbus server settings
Setup Item Selectable Range or Selections Default Value Setting
Server number 1-8/9-16 1-8
Port
Modbus server name
Unit
No.

0 to 65535
64 characters or less
Auto/Fixed
0 to 255

502
–
Auto
1

Communication (Ethernet) > Modbus client > Command settings
Setup Item Selectable Range or Selections Default Value Setting
Client command number 1-8/9-16 1-8
1 to 16
First
Last
Server
Regi.
Type

Off/R/R-M/W/W-M/E-M
Depends on the command type.
Depends on the command type.
1/2/3/.../15/16
Numerical value
INT16/UINT16/INT32_B/INT32_L/UINT32_B/
UINT32_L/FLOAT_B/FLOAT_L

Off
–
–
1
30001
INT16

Communication (Ethernet) > Password management > KDC connection (/AS1 option)
Setup Item Selectable Range or Selections Default Value Setting
KDC connection Primary/Secondary Primary
KDC server name 64 characters or less –
Port number 0 to 65535 88

Setup Items and Default Values
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Communication (Ethernet) > Password management > Certification key (/AS1 option)
Setup Item Selectable Range or Selections Default Value Setting
Host principal 20 characters or less –
Realm name 64 characters or less –
Password 20 characters or less –
Encryption AES128/AES256/ARC4 AES128

Communication (Serial) > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Baud rate 1200/2400/4800/9600/19200/38400 9600
Data length 7/8 8
Parity Odd/Even/None Even
Handshaking Off:Off/XON:XON/XON:RS/CS:RS Off:Off
Address 1 to 99 1
Protocol Normal/Modbus/Modbus-M Normal
With /AS1
The baud rate, data length, parity, handshaking, address items are the same as on a DX without the /AS1 option.
Protocol Normal/Modbus/Modbus-M/Barcode Normal

Communication (Serial) > Modbus master > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s
Timeout 125ms/250ms/500ms/1s/2s/5s/10s/1min 1s
Retrials Off/1/2/3/4/5/10/20 1
Inter-block delay Off/5ms/10ms/15ms/45ms/100ms Off
Auto recovery Off/1min/2min/5min/10min/20min/30min/1h 2min

Communication (Serial) > Modbus master > Command settings
Setup Item Selectable Range or Selections Default Value Setting
Master command number 1-8/9-16 1-8
1 to 16
First
Last
Addr.
Regi.
Type

Off/R/R-M/W/W-M
Depends on the command type.
Depends on the command type.
1 to 247
Numerical value
INT16/UINT16/INT32_B/INT32_L/UINT32_B/ 
UINT32_L/FLOAT_B/FLOAT_L

Off
–
–
1
30001
INT16

Communication (PROFIBUS-DP)
Setup Item Selectable Range or Selections Default Value Setting
Node Address 0 to 125 3

Setup Items and Default Values
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Status relay
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Fail relay Fail/Status relay Fail
Status relay Fail/Status relay Status relay
With /AS1
Fail relay Fail/Status relay/Mem. sample/Invalid user/Login Fail
Status relay Fail/Status relay/Mem. sample/Invalid user/Login Status relay

Status Relay > Status Relay Details
Setup Item Selectable Range or Selections Default Value Setting
Memory/Media status On/Off Off
Measurement error On/Off Off
Communication error On/Off Off
Memory stop On/Off Off
Alarm On/Off Off

Set Calibration
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Notification 1 to 10 1
Renotification 10min/30min/1h/8h/24h 1h

End
Setup Item Selectable Range or Selections Default Value Setting
Do you want to store and 
make the new settings take effect?

Yes/No/Cancel –

Setup Items and Default Values
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File/Initialize tab
Load settings
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Load settings > Kind CF/USB CF
Initialize > Kind Clear 1/Clear 2/Clear 3 Clear 3
Media eject CF/USB –
Touch panel calibration Execute/Check –
With /AS1
Load settings > All settings > Kind CF/USB CF
Load settings > Login info only > Kind CF/USB CF
Load settings > Other settings > Kind CF/USB CF
Initialize > Kind Clear 1/Clear 2/Clear 3/Clear 4 Clear 3
Media eject CF/USB –
Touch panel calibration Execute/Check –

End
Setup Item Selectable Range or Selections Default Value Setting
Do you want to store and 
make the new settings take effect?

Yes/No/Cancel –

Setup Items and Default Values
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List of Operator Menu Items

The operator menu is a shortcut to the items in the operation screen menu and the 
FUNC key menu.
There are limits on the functionality of the operator menu. For example, you may not be 
able to use some features due to user authority or in situations where there is no data.
You cannot tap the buttons that correspond to features that are disabled (the text on the 
buttons is displayed in gray).

	 For details on user limitations and operations when you are not logged in, see IM 
04L42B01-01EN.

Operation screen
DescriptionOperator menu

Trend
Message Writes a message
Free message Writes a free message
Trend history Displays the historical trend
AlarmACK Performs alarm acknowledgment
Home Displays the specified standard display
Operation screen menu Displays the Operation screen menu
FUNC key menu Displays the FUNC key menu

Trend history (*1)
Data search Displays the calendar
All data display Shows the all data display

Information
Displays the information menu that is used to 
switch to the alarm summary, message summary, 
information, and operation log (/AS1)(*3) for the 
historical trend

Exit history Exits the historical trend display
Add message Writes an additional message
Add free message Writes an additional free message
Sign record (*2) Displays the sign record menu (/AS1)
AlarmACK Performs alarm acknowledgment
Operation screen menu Displays the Operation screen menu
FUNC key menu Displays the FUNC key menu

Overview
AlarmACK Performs alarm acknowledgment
Alarm DispRST (*4) Resets the alarm display
Individ AlarmACK (*5) Displays the individual alarm acknowledgment menu
Jump to alm sum Displays the alarm summary
Jump to trend Displays the trend of the specified channel
Home Displays the specified standard display
Operation screen menu Displays the Operation screen menu
FUNC key menu Displays the FUNC key menu

*1	 When the historical data is invalid and no waveforms are displayed, the following three items 
are displayed on the operator menu. 
Exit history, operation screen menu, and FUNC key menu

*2 Sign record is displayed under the following conditions. 
(1) The DX has the /AS1 option, (2) the DX has the sign record feature, (3) a user has 
logged in using keys, and (4) the internal memory’s historical data is being read.

*3	 The information menu’s operation log is only displayed on DXs with the /AS1 advanced 
security option.

*4	 Alarm DispRST is displayed under the following conditions. 
(1) Annunciator mode is turned on and (2) the alarm sequence is ISA-M.

*5	 Individ AlarmACK is displayed under the following conditions. 
(1) The DX has the /AS1 advanced security option, (2) annunciator mode is turned off, (3) 
the alarm indication behavior is set to Hold, and (4) the relay output status that is enabled 
after the alarm ACK operation is set to Reset.
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Operation screen DescriptionOperator menu
Alarm summary

AlarmACK Performs alarm acknowledgment

History (DISP) (*6) Displays the historical trend (display data) including 
the selected item

History (EVENT) (*6) Displays the historical trend (event data) including 
the selected item

To history (*7) Displays the historical trend including the selected 
item

Information (*8)
Displays the information menu that is used to 
switch to the alarm summary, message summary, 
information, and operation log (/AS1)(*3) for the 
historical trend

Exit history (*8) Exits the historical trend display
Home Displays the specified standard display
Operation screen menu Displays the Operation screen menu
FUNC key menu Displays the FUNC key menu

Message summary

Time or username Switches between displaying the time and the user 
name

History (DISP) (*6) Displays the historical trend (display data) including 
the selected item

History (EVENT) (*6) Displays the historical trend (event data) including 
the selected item

To history (*7) Displays the historical trend including the selected 
item

Information (*8)
Displays the information menu that is used to 
switch to the alarm summary, message summary, 
information, and operation log (/AS1)(*3) for the 
historical trend

Exit history (*8) Exits the historical trend display
AlarmACK Performs alarm acknowledgment
Home Displays the specified standard display
Operation screen menu Displays the Operation screen menu
FUNC key menu Displays the FUNC key menu

Memory summary
To history (*9) Displays the historical trend of the specified data
Select save Saves the specified data
All save Saves all data
M.sample save (*10) Saves the manual sampled data
Report save (*10) Saves the report data

Time or filename Switches between displaying the time and the file 
name

Save mode (*9) Switches to save mode
AlarmACK (*9) Performs alarm acknowledgment
Home (*9) Displays the specified standard display
Exit (*10) Exits save mode
Media eject Ejects media
Operation screen menu Displays the Operation screen menu
FUNC key menu Displays the FUNC key menu

Custom display
Message Writes a message
Free message Writes a free message
AlarmACK Performs alarm acknowledgment
Trend history Displays the historical trend
Home Displays the specified standard display
Operation screen menu Displays the Operation screen menu
FUNC key menu Displays the FUNC key menu

*6	 This is displayed when both display data and event data have been recorded.
*7	 This is displayed when display data or event data has been recorded.
*8	 This is displayed when the alarm summary or message summary for the historical trend is 

displayed.
*9	 This is not displayed when the memory summary is in save mode.
*10	This is displayed when the memory summary is in save mode.

List of Operator Menu Items
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Operation screen DescriptionOperator menu
Operation log (*11)

Change contents Switches the screen contents
Trend history (*12) Displays the historical trend

Information (*12)
Displays the information menu that is used to 
switch to the alarm summary, message summary, 
information, and operation log (/AS1)(*3) for the 
historical trend

Exit history (*12) Exits the historical trend display
AlarmACK Performs alarm acknowledgment
Home13 Displays the specified standard display
Operation screen menu Displays the Operation screen menu
FUNC key menu Displays the FUNC key menu

Annunciator
AlarmACK Performs alarm acknowledgment
Alarm DispRST Resets the alarm display
Home Displays the specified standard display
Operation screen menu Displays the Operation screen menu
FUNC key menu Displays the FUNC key menu

Multi batch overview
Batch view Switches to batch mode
AlarmACK Performs alarm acknowledgment
Home Displays the specified standard display
Operation screen menu Displays the Operation screen menu
FUNC key menu Displays the FUNC key menu

Other screens (*13)
AlarmACK Performs alarm acknowledgment
Home Displays the specified standard display
Operation screen menu Displays the Operation screen menu
FUNC key menu Displays the FUNC key menu

*11	This only appears on DXs with the /AS1 advanced security option.
*12	This is the operation log menu for the historical trend.
*13	The digital, bar graph, report data, various log (excluding the operation log), Modbus status 

(RTU/TCP), relay status, text field, network information, system information, stacked bar 
graph, and event switch display screens.

List of Operator Menu Items
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